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You can find short tutorial videos on V-Note here:

http://bit.ly/2cqBRxM
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Chapter 1: Getting Started

An Overview of V-Note

V-Note is designed for those of us who work with videos. Using multiple timelines,
hot keys, online sharing and collaboration, transcripts, drawing, raw data output,
and numerous other features, V-Note can offer a video analysis experience like no
other.

Opening V-Note

When you first open V-Note, you will see the opening screen. From there, you can
choose to open (left to right): a new project; a locally saved project; or an online
project.

At the bottom, you can also click on Manuals or Tutorials to view these. Note: your
web browser will be opened and directed to up-to-date resources.

Mouse to the top to view menu options.

We will click “New” to begin.



Bringing Videos into V-Note

Once you click “New” on the blue splash screen, the first thing you may want to do is
bring a video into your V-Note project (V-

& V-NotePro File Online Edit View Timeline Transcript Playback Tools

Note’s main file format which maintains and o
‘.

associates all of your media, transcripts,
timeline data, etc). You can do this by
opening a folder on your desktop and
dragging in a media file in the following
formats: .mp4, WebM (VP8), H.264, .mov,
*wmv, or .mp3.

ot/

[—:L / >ﬁm

Alternatively, you can double click the
video play window (black space) to browse Il Actvate Add Vido Later” odo

to a video file. [_

Multiple videos can also be added by dragging them into the player window or by
clicking, on the top menu: > File > Edit Playback Sources.

*wmv files are only supported in a Windows® environment

Playing and Navigating a Video

To show the player controls, move your mouse over the video. The controls will
appear. They will then disappear after a few seconds of no mouse movement, to
allow better viewing. & V-NotePro File Online Edit View Timeline Transcript Playback Too

V-Note Pro 2.
To start or stop play, click on the
large triangle representing

Mplay."

The bar below the video play
window will provide a preview
thumbnail of the video when
you hover over it. This can help << } 24 g
you to rapidly locate parts of a 1 - < Fa
video. g &

CED) P2

00:02:13.050

To change the play head position
you can single-click on the —
timeline you can click anywhere on the blue bar below the video or double-click on
the timelines. You can also drag the play-head left or right to ‘scrub’ through the
video.
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Press & Hold

Buttons Play Forward Thru
1/2 speed Video

Backward Thru

Zoom In/Out

Video (pan with mouse)
Move Play
Controls
T Adjust Volume

Play Speed (multiple tracks if applic.)
(click to adjust) Frame by Invert

Frame Colors

Play/Pause

Note: all buttons’ speeds can be adjusted in >Preferences > Playback Settings

Removing a Video from V-Note

To remove a video or audio file from your V-Note project you can click on the File
menu on top. Choose “Edit Playback Sources.” Next, select the media file you wish

to remove and choose “Remove
Audio or Video.”

LY

Note: you cannot remove a
video from a file that has
already been saved to or
downloaded from the cloud.
Instead, start a new project.

If you want to locate the video
file from the earlier-saved
project, you can browse to it by
clicking: File Menu > Edit
Playback Sources. Then, Right-
Click the video. This will allow
you to browse to the file.

@ V-NotePro File Online Edit View Timeline Transcript Playback  Tot

New Project V-Note Pro 2,
Open Project

Recent Projects

Save Project

Save Project As...

Close Project

Edit Playback Sources
Clear Playback Sources

Export Histogram
Export Raw Data

Overlap Statistics
Nested Statistics
Boolean

Project Details

Close Application

If a project has been saved from a shared project on our cloud-based streaming
services, the related video will be saved only as a temp file or it may not be saved

locally at all, depending on their chosen security settings. Please contact the original

owner to obtain the original.

9 V-Note User Manual



Playback Sources

Playback mode: Parallel Mode

Files:

Teaching Video.mp4 [ offset: 0 secs ]
US4 Rocks.mp4 [ offset: 0 secs ]

Add Remove Sync Videos Clear All

Output Layout

Rows: Columns: 2

Cancel

Custom Settings

V-Note allows you to make functional changes such as: function-key assignments
(e.g., shortcut keys for: save project, advance looping, etc.), languages and the
default font used by the program.

This functionality is accessed via the “Preferences” or “Settings” menu. This is
accessed differently depending on platform. It is the only difference between
Mac® and Windows® with V-Note, as it is a function of its respective operating
system.

On a Mac: RIRZ Y File Onine Edit

About V-Note

Choose top menu: V-Note > Preferences

Services >

Hide V-Note #H
Hide Others X H

Quit V-Note #Q

\]
On Windows- File Online | Edit = View Timeline Transcript

A VEESTES «  Undo Ctrl-Z
Ctrl=Shift+Z

Choose top menu: Edit > Preferences

Ctrl+ Shift+S
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Changing V-Note’s Language

To change the language in which V-Note is displayed, choose “Preferences” or
“Settings” per the previous page’s instructions. Then Choose: “User Interface
Settings” and then: “Language.” Next, select your preferred language.

V-Note can be displayed in: English (US), German, French (FR), Spanish (MX),
Italian, Portuguese, Mandarin, Japanese, Korean, and Serbian.

V-Note Settings

You can also contribute a

. ) User Interface Settings Language +/ English
translation in your Keyboard Settings Deutsch
. Overlay Settings
language which we can Storage Settings I B
. Playback Settings ian
usually add in a few days. Network Settings = I )
. . sk Again De
Click: Tools > Translation AskAgainDe Lo
Editor > Add New ¥ Ask Again Re [isiaki
: ¥ Ask AgainRe  [{Language name:}]
Translation. Please note ¥ Ask Again Clc Tt

Ask Again Clear Frame (Drawings)

that translations must be
complete and in one
complete file before they
can be accepted. You may
also request us to add a new language here: info@v-note.org

Changing Shortcut Keys

V-Note Settings

User Interface Settings Group ~ | Action Shortcut
Keyboard Settings View Labeling Buttons Side-Bar
You can Change the keys used to Overlay Settings View Video Display
R . . Storage Settings V!ew Gen?ral Notes
control certain functions in V- Playback Settings View Media nfo )
. . Network Settings View Show Segments And Histogram
Note. When viewing o Soyseen
“Preferences,” accessed as View Vo Diply atachd
described above, select i S
“Keyboard Settings.” View Tt
View Fullscreen
View Pending Uploads
. . View Timeline
For example, saving a pr0]ect xiew mol\/iepeuilderw -
. iew ulti-Project Workshop
(CTRL + S; 38 + S in MacOS); View Waveforms
. . . View Drawings Label
View Drawing Tools
beglnnlng and endlng an View Video ghange Graph
utterance when transcribing e Tt LnKS ity
(CTRL + Shift + Enter; 38 + Shift | ikl
+ Enter in MacOS), etc., can all LR
: . : Shortcut: Reset to Defaults
be given new key combinations.
Note, however, that single Close

alpha-numeric keys must be avoided, as these may be used when typing words in
transcriptions, for example.
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Changing Shortcut Keys: An Example

If you wanted to change “View - Full Screen” (see image below) from unassigned
(default) to CTRL + F (38 + F on Mac 0S), then select “View - Full Screen” with the
mouse so that it becomes highlighted. Next, type the key combination of your
choice into the text bar below the list next to the word “Shortcut.” Next, click on the
“Set” button; and finally, click “Apply.”

V-Note Settings

User Interface Settings Group v | Action | Shortcut
Keyboard Settings View Labeling Buttons Side-Bar
Overlay Settings View Video Display
Storage Settings View General Notes
Playback Settings View Media Info
Network Settings View Show Segments And Histogram
View Show Only Histogram
View Show Only Segments
View Full Screen Playback
View Video Display Detached
View Drawing Actions
View Private Messages
View Project Overview
View Transcript
View Fullscreen
View Pending Uploads
View Timeline
View Movie Builder
View Multi-Project Workshop
View Waveforms
View Drawings Label
View Drawing Tools
View Video Change Graph
View Text Links
View Interrater Reliability
Transcription Finish Utterance

Tranaarintian Chart Naw L IAranan

Action: Fullscreen

Shortcut: 38F Reset to Defaults

Close

Once the change is made, CTRL + F (or, 3 + F on Mac 0S), when pressed together,
will toggle full screen on and off.
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Overlay Settings — Adjusting Subtitles

Overlay settings allow you to select a font, a font color, and font size for your
subtitles, which display over top of the video. Subtitles can be imported from .srt,
.csv, xlsx; or they can be made within V-Note by transcribing.

Adjusting the Size of Parts of V-Note

You can adjust the size of your video play window, the transcription window, and
the timeline window, etc., by simply placing your mouse’s cursor between any
two windows, clicking, and dragging in the direction you choose. The Movie
Builder window is not able to be reduced in size.

This allows you to emphasize the function of your choice at any given time. For
example, you can make the video play window or transcript window nearly full
screen if you desire.

You an even make the transcription and timeline windows disappear by continuing
to drag the video window’s edge all the way through the other windows. You can
still continue to use hotkeys even if the timeline window is shrunk from view, for
example. These can be useful when using an audio-only project for example.
Example screen setups are shown below.

To make the video play window as fullscreen, double-click it.

To detach the play window,

K i R I V-NotePro File Online Edit View Timeline Transcript Playb
click top menu: > View > Video

. . . o Labeling Buttons Side-Bar

Display Detached. This will Text Links
permit you to drag around and Interrater Reliability
resize the play window Transcitl

. . - Project Overview
separately from the timelines or 1= : _ conoti
other element of V-Note, for ; Drawing Actions
example, onto a second screen. ’ e
This can also furnish more Video Display

. . . Video Display Detached
vertical space for timelines. —

Video Change Graph
Waveforms

Timeline

13 V-Note User Manual



Adjusting Playback Speed

Playback speed can be adjusted to be made faster or slower. Simply, click on the
1.0 button in the lower right of the video player controls and adjust the slider up for
faster play or down for slower play. 1.0, in the middle, is normal play speed.
Clicking “Custom” allows you to input via the keyboard an exact speed for playback.

Custom

4.0

TRIEON 22232

Note that sound will play sped up until 10X speed, after which, the sound will not be
reproduced, this is in part to reduce processing load and in part to avoid
unintelligible and potentially uncomfortable high-pitched sounds.

Adjusted speed will apply anytime the play button, press-and-hold play button and
half speed buttons are used. It must be changed again to revert to a normal (i.e., 1.0)
play speed.

You can change the preset values for the FFW and RWD buttons via the menus for

preferences / settings on page 9. Then, choose “Playback Settings.” See image on
next page.
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V-Note Settings

User Interface Settings

Keyboard Settings Maximum Output Resolution: 1280px X 720px

Overlay Settings Skip Non-Ref Frames

Storage Settlr'\gs Skips all frames that can be safely discarded without degrading video quality of next frame.
Playback Settings For videos with higher framerate (60 fps or above) this might lower effective framerate to values

Network Settings as low as 20fps. : : : : . :
Enable this option if you experience any problems with stuttering while playing high fps videos.

v Skip Loop Filter

Disables loop filter when decoding video.This will save some CPU resources at cost of video
quality (video will look more "blocky")

v Skip IDCT

Disables IDCT when decoding video.This will save some CPU resources at cost of video quality
(video will look more "blocky")

v Use Accelerated Video Rendering
Start Playback When Project Is Opened
Loop Video
Use Quick Seek

v Generate Thumbnails (restart required)

Restore Defaults

Speed Up/Down Factor: 2.00x
Drop Audio Frames For Speeds Above: 8.0x

Decode Only Keyframes For Speeds Above: 8.0x
Preset Speeds Used For Press And Hold Playback

Slow: Fast: Very Fast: Fast Forward:

0.50x 2.00x 4.00x 10.00x
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Chapter 2: Timelines and Labels

What are Timelines, Labels?

When V-Note first opens, there are four timelines with four labels that are open by
default. The default labels, shown in

the image to the right, are “Label 1,” _
“Label 2,” “Label 3,” and “Label 4.” oo
These are just to the left of their [z M
corresponding hotkeys and timelines, [ e
which are white and punctuated by I%IE
times above on the black bar (i.e.,

00:01:00).

+|+]|+]|+

If you want to bring the play head to 01:00, a double click at this point on the
timelines (anywhere outside of a labeled instance) will bring the play head to this
position. You can also scrub the video by dragging the playhead.

The drawings label can be toggled on/off under the “View” menu on top.

Creating, Changing, and Deleting Labels

Labels, including the default ones, can be changed, deleted or added. To modify a
label, click on the text to edit and type in a new label, as shown. This could be
anything you might wish to mark in
the video (e.g., a name of a person,
questions, “interesting,” etc.).

You can also change a “hot key” - Label 1 . +

the key that is pressed to begin and %
end coding (i.e.,, marking a labeled | Label 2 |. + |
instance) by clicking on the “hot -
key” (e.g., A, B, C, etc.). Similarly, clicking on the color square allows you to change
the color of the label.

To add a new label, click on the . button. New
labels will appear below existing labels. These can be

changed in label, color, hot key, in the same way shown )
above. Add Label

Shortcut: Ctrl+Shift+N

To delete a label (including the default ones), a right click
over the label (or Control + Click on a Mac) provides the
option to Delete Label.
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Note: you can create as many labels as you would like. Use the “Shift” key to
increase the number of labels. “A” is different than “a” as a label, then.

Even if you run out of keys, you can make more buttons. You will then want to
display the clickable buttons to the left of the screen. Display these by toggling on
the “>” button on the top right of the screen on the gray bar. The buttons display as
shown in the image below, to the left of the video play window.

Unlike the timeline labels below, these are clickable and can be displayed in the
hundreds, as they will shrink to accommodate large numbers of labels.

V-Note Pro File

Student Resp

Labeling Instances of Video

To label an instance of video - for example, parts
of the video where Judy is talking - first create a
label for Judy with the hot key “],” for example.

Next, watch the video. Whenever Judy speaks, simply press the “J” key to start and
stop the label on the time line for Judy. The resulting labeled instances on the
timeline will look something like this:

[ [ [ ] | [ [ [ ] 1]
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Changing, Editing, and Deleting Labeled Instances

Labeled instances (i.e., coded instances) can be changed, edited, or deleted. Also
notes can be made on them.

| A right click over a labeled instance bar allows a user

[ Edit L] _| to delete a labeled instance as shown to the left.
Delete
| Add to Multi-Project Workshop | | Holding the mouse over center of the labeled instance
[ Play from here | and clicking allows you to move the labeled instance
left and right.

Holding the mouse cursor over the left and right edges allows you to stretch or
compress the labeled instance from that side by dragging the edge left or right.

Edit Segment

To make notes on the
labeled instance, double-

click it. You will see this Start: 02:37.373_|

window: End: 02:56.121 Reopen Segment
Duration: 00:17.748 Duration Fixed

The note will appear in the Notes go here

labeled instance as shown

belOW: Description Notes:

j INotes go here.I D

Cancel

Any notes extending beyond the labeled instance box will be elided for timeline
display but saved entirely for viewing in the dialogue above and for export.

Adjusting the Function of Making Labeled Instances

Directly below the timelines, on the gray bar are some options to change how
labeled instances are made. There are two general choices: Double Press Mode and
Single Press Mode.

When watching and coding a video, if you would like to start and stop the labeling
of the instances with two presses of the hotkey (i.e., one to start and the other to
finish), then choose “Double Press Mode.” If, however, your instances are all about
the same time, you can choose “Single Press Mode” and preselect a time for all
labeled instances.
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You will then only need to
press the key once to create S S RO
(i.e, start and stop) alabeled ® Double Press Mode
instance on your timeline. = __2.000

The - buttons

allow you to change between
the two types. The cog
wheel provides detailed
access and the 2X / 1X
button will toggle between
Single Press and Double
Press modes for all hot keys,
unless individual buttons are set otherwise.

0.000

To set individual buttons irrespective of the global setting (double/single-press
modes), right click on the gray area near the name of the label (left of the timelines)
and choose “Labeling Mode.”

The lead-time of labeled instances can be set for both. When watching and coding a
video you may need a few seconds, for example, to recognize that a question was
asked, a goal was indeed scored, etc. By setting the lead-time open to 2.0 seconds,
for example, when a hot key is pressed, the beginning of the labeled instance is
placed 2 seconds before you hit the hotkey. Similarly, the close lead-time (only on
“Double press mode”) can place the end the labeled instance before the time at
which you pressed the hot key.

Exporting and Repurposing Labels and Timelines Only

If you would like to reuse the same labels in multiple projects (e.g., players’
names, teaching rating categories, etc.), V-Note makes it easy.

There are two buttons under the timelines at the right called: “Import
Labels/Timelines” and “Export Labels/Timelines. These buttons are show below.

They allow you to export and import (i.e., bring into to another project) your labels
and/or timelines.
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When you click on “Export Labels/Timelines” . below the timelines you

can choose only to “Export Labels” (these are the buttons and hotkeys on the left) or
both “Labels and Timelines.” This, latter option, may be useful if, for example, you
have videos from multiple angles of the same event; this way the timeline labels
would line up in the same way. If you do not have the new video of the same event
to apply these to, you will likely want to only export the labels.

Note: the distinction must be made between these choices only when exporting.
Once exported, these will appear as a .vntl file, which can only be opened by V-Note.

To import labels and timelines, use the “Import Labels/Timeline” - button.
These files will become visible and able to be chosen for importing into a new
project.

You can align a new video (with perhaps a slightly different record-begin-time)
with the existing imported timelines more exactly by choosing on the top menu: >
Timelines > Edit Timeline Offset.

Nested (Hierarchical) Labels (Codes)

Depending on your goals, you may find it helpful to use nested labels (codes) in your
video analysis work. You can benefit in two ways: a quick visual scan of the
timelines within V-Note reveals relationships of
hierarchy; and you can analyze and compare codes
within the hierarchy with our built-in descriptive
S.tatIStICS for nested codes to determine relative B Click on the “+” to
times, for example.

To Make Nested Labels:

the right of the label
name, color and hot
o S image to the left
i label1 || + | or

B Rightclickin the
Label 2 . + ‘ gray space near and
around the label

name and choose
Below is shown an example of nested codes for a “Add Sub-Label”

baseball player. Note that “Jones” is the name of
the player and other labels (codes) appear below.
“Up to bat” is one such code; below it are things that must happen when he is up to
bat (i.e., sub-codes or nested labels) including: hit, foul, run, strike. “Catch” while
still under “Jones” is not going to occur while up to bat, and this is shown by the
labels’ organization.
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Sub-sub-labels and even further
levels can also be made in the
same way as described above.
Note the labels to the right.

Analyzing your nested labeled

| instances can be done with our
built-in descriptive statistics.

I Please see Chapter 15 for more on

this feature.

Adding and Using Tags

Tags are small markings that can be seen

Title Description

within V-Note and exported in raw data to = important

Repeated

further refine a cod. They could serve to
mark a code as important, for example. To
add tags, choose: > Timelines > Edit Tags.
Then, click “Add” to choose a name and a
color. Tags can be applied to any labeled
instances (codes) regardless of hierarchy.

Cancel

To apply a tag, double click any labeled instance to reveal the “Edit Segment” where
you can add notes and edit start and end times. If you have created any tags they
will be available to the right to be checked on or off.

Tags will appear as below Edit Segment
on the top right corner of a

labeled instance.
In this example, -
the green dot

represents the tag. These

will also export in raw data
as described in that section |ESEEIEEE
of this manual.

Start: 07:16.378 Tags

End: 07:38.932 Reopen Segment M important

Duration: | 00:22.554 | Duration Fixed Repeated

Cancel
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Boolean Key Combinations

V-Note allows you to combine hotkeys so that when one is pressed another is
effected as well. This can allow you to avoid redundant keypresses and easily
combine two or more labels (codes).

Boolean notation involves modifiers such as: AND, OR, NOT, NOR, NAND, and
XOR.

To create Boolean combination choose: > File > Boolean > Key Combinations
V-Note Pro = File Online Edit View Timeling)

New Project
Open Project
Recent Projects
Save Project
Save Project As...
Close Project

Edit Playback Sources

Export Histogram
Export Raw Data

Overlap Statistics
Nested Statistics
Boolean Key Combinations

A X Add Boolean Analysis Label
Project Details

Close Application

On the following page are a few examples as they will be entered in V-Note.

The Single Press Key section at the top shows that when

T + X (Shift + X) at the same time will apply the labels/hotkeys a & b for 6 seconds.
This is a fixed duration because this is single-press mode. You may set any duration.

The same: double press key space allows you to start and stop multiple
hotkeys/labels at one time with a single key for a duration determined by the
pressing of the key. When the key is pressed the labels (codes) will be opened.
When it is pressed again they will be closed. Note that it is possible to set an open
lead time which can allow for your reaction time (e.g., taking a few seconds to
realize, in fact, a question has been asked). This will place your labels a few seconds
(or whatever time you choose) before the time at which you pressed the key. Itis
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not possible to select a lead close time; but the end time can be modified anytime by
dragging the end to the desired position.

Different: Double Press Key allows for further customization while coding. If you
begin a labeled instance (code) with a given key, multiple hotkeys/labels will be
applied, then, depending on your ending hotkey (chosen in the moment), only the
ones chosen per the ending-hotkey will be applied. All will apply initially and be
shown onscreen as being applied, however. The extra ones will disappear upon
ending.

@ L Boolean Keystrokes
Single Press Key

Press This Key To Enable These Labels For This Long Add

oX ab 6 Remove

Same: Double Press Key

Press This Key To Enable These Labels Lead Open Time Add

y a.c 2 Remove

Different: Double Press Key

Start: Press This Key End: Press This Key To Enable These Labels Lead Open Time Add

Remove

Close

|+
|-

Boolean Analysis Functions are detailed in Chapter 15 and are applied post coding
to show points of specific overlap among codes or coders.
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Chapter 3: Working With Projects

What is a Project?

A project in V-Note contains your video and all related parts into one file. When a
project is opened in V-Note, it opens: your video, any transcripts made previously,
any labels and labeled instances on timelines made previously, notes, drawings,
interrater-reliability data, etc.

Saving and Opening a Project Locally

If you have Opened a VideO in V-Note and @ V-NotePro File Online Edit View Timeline
added some labels and labeled instances ® New Project
. . 1 ‘ Open Project
as described previously, you can create a e BRSSO
project by clicking the “File” menu and Save Project
“Save Project As...” This will prompt a Suve Project A

Close Project

browse window where you can select a

. . Edit Playback S
title and a folder for saving. i

Clear Playback Sources

The icon of the saved project will appear Bpot L
as below. The extension on V-Note Export Raw Data
project files is .vpnr. When this project is .
. . Nested Statistics
opened in the future, it Boolean
will immediately open R
your video and any parts e

added to the project such
BBC Forest.vnpr  as transcripts or labeled instances.

Publishing a Project Online

Once a project has been saved locally, it can be saved, or published online for
collaboration with others, or for easy access from multiple devices.

To save a project to V-Note’s online servers you must have V-Note collaboration
space with open time remaining. Some space is offered free for all users, so you can
try this feature at no cost. If you would like to purchase more collaboration space
for more or larger projects, you can log on here to do so:

http://v-note.org/login
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Note that users with whom a project is shared do not require their own
collaboration space. Any project may be shared with as many users as many times
as you wish.

Online Edit View Timeline Transcript

You can click the “Online” menu on top and

LEOS “Publish Project.”
Recent Online Projects

Publish Project Depending on the size of the video file and the
speed of your Internet connection the upload
Passcode Manager may take from several minutes to several hours.

Progress of the upload can be seen in the upper
right part of the screen by clicking the cloud
with the up arrow. When they show as “Done”
and turn green, the uploads have completed
successfully.

Join Project Using Passcode

Browse Online Projects

Note: uploaded videos will be converted to .mp4 file types of about 400 kbps for
better streaming performance. Audio will be converted to mono 64 kbps

S O B badonem L] (equivalent sound quality to the common
standard of 128kbps stereo). If stored locally,

Video: Cyndi Lauper - Time After Time.mp4 Done K i K K
Upload completed your video will continue to be played in

Project: Test Project.vnpr bere | original quality on the computer it was created
) and uploaded by default.

Your videos and projects are stored
securely on our server, to be accessed only
with your password behind an SSL certificate
that provides encryption and secure
transmission to your device and only your device. When you share access to others
working on the same project, they will have access to the video also.

Cancel All

Sharing a Project with Others
There are two ways to share projects with others.
1. Create a code that others can use to access your projects and provide input.
This can be ideal for sharing with large numbers of people, but anyone with

the code can join and view your video.

2. Add auser or users directly to your project individually with their V-Note
user name. This is more secure, as only the users you specifically type in can
view the project.
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To create a code for sharing your project, Online  Edit View Timeline
first make sure your video has been uploaded Logout

to V-Note’s online storage and streaming Recent Online Projects
service. Next, choose the “Online” top menu,

Publish Project
then “Passcode Manager.”

Passcode Manager

A dialog opens. Select “Generate Passcode.”
You will have two choices for the new user’s
permission level. Browse Online Projects

Join Project Using Passcode

The first choice, “Full Access: User can see
everything,” allows the user to see
everything in the project including: pre-existing labeled instances, labels and hot
keys, transcripts. The second choice, “Blind: User cannot see timelines made by
others,” allows a user to see everything except any pre-existing labeled instances
(i.e., codes) others may have made. This allows for a truly independent video coding

Passcode Manager
® All projects

L Passcode Privileges | Playback Mode | Created Expires
krets brothers speech2text test 91EBF326E15CB794A656FE70D06A8SFO9FE6CABDE Full Regular Thu Aug 19 07:52:51 2021 Fri Nov 26 07:52:43 2021

Generate Passcode Remove Passcode Copy Passcode To Clipboard

experience in which one user cannot see other users’ codes. A user joining with this
setting will still see the labels and hot keys that are pre-existing and be able to add
codes to these same timelines (although these are placed under his or her name and
are easily differentiated; more on this later).

Generate New Passcode

Project: krets brothers speech2text test ( ID: 354 )

Privileges v/ Blind : User can't see timelines made by others
Full Access: User can see everything
Playback Mode: | Regular Playback

Expires on: 10/4/211211PM v

Generate Cancel
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An expiration date for using the code to join the project is also able to be set. The
default time is 1 week from the time the code is made, but this can be changed. This
is the time before which the code must be used to join the project. After this the

code is no longer valid. Anew [a50o emerTE——
code can be made at any time.
. . u g
A user will still have access e
. Username Privileges
to the project when the brandon (owner)
: : matthew Can see everything
passcode expires if she or he it Can s66 everything
has already joined. HOWGVGF, sglimcher Can't see timelines made by other users
. nefahrer Can't see timelines made by other users
the passcode will cease to mcpatberg Can't see timelines made by other users
f . f zackeryl Can't see timelines made by other users
unction for new users. nandipatiraju Can't see timelines made by other users
Multiple codes having b Canl ses Tmepnes mage p¥ oler ser
different permission levels New user
and different expiration dates Username: | Add |
can be made fOI' the same Privileges: | Can't see timelines made by other users v
project.
Remove Close
To add or remove users

manually, select the “Online”
top menu and then “Edit Project’s Users.” The dialog to the right appears, which
allows for the selection, addition and removal of users.

To remove a user, select his or her name and then “Remove.” This will also remove
all data contributed by that user, including: labels, labeled instances, and transcript
utterances. Similarly, if a user deletes their codes, transcripts, or whole
account or has it deleted (e.g., canceled) their data will disappear from your
project. It is their data and is associated with their permissions and account. Itis
never possible to change other users’ codes, transcripts, etc. to preserve fidelity in
coding. Any local backups (> File > Save (as)) can safeguard all user data at the
time of the save - even that of users that may later leave. It is imperative that you
make regular backups locally.

To add a user, type his or her user name into the white bar marked “Username.”
Note that a username is specific to V-Note and may be different that his or her actual
name or email. Verify the username with the person before adding him or her;
these will NOT be his or her email address.

To change the permissions of a user, the user name can be doubled clicked and the
choice made.
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Security for Collaboration

To allow our users to balance convenience and security per their needs, V-Note
offers variable settings. V-Note guarantees that - if you are permitted to use video
in your setting - that collaborative use of V-Note and all locally-stored functions
should be permitted by your Office of Research Protections / Internal Review Board
(ORP/IRB). Our level 3 security setting allows us to make this guarantee.

In all sharing options, both the V-Note server and client side (i.e., your computer)
sends your video as an encrypted file that is protected from interception via wifi or
other network connections. Our servers also store you videos encrypted using
hashed passwords. We do not ourselves have access to your videos.

Customizable security levels are:

28

b.

1. Default: Emphasizes convenience in collaboration
a.

Allows collaborative V-Note users to export their own videos by
stringing clips together

Caches alocal copy of unencrypted videos on users’ computers (with
whom you have shared a project), so that they can work without an
internet connection

Suitable to for sporting events or other public events where the video
recording is not of a sensitive nature

This is the mode that is active by default; you need take no action for
this functionality to be in effect

2. Restricted: Balances convenience and security
a.

Collaborative users are not permitted to export new videos (e.g., from
clips) using V-Note. Note that it is still technically possible to do a
screen capture recording

Although a local copy is cached for smoother operation, this copy is
encrypted, and closing V-Note removes the copy completely. Internet
connection is required with this setting

This can be employed for somewhat more sensitive videos per your
judgement

To select this setting, you can activate it per specific user or for a given
share code for all users using that share code.

To select security level 2 for a passcode to be shared with multiple
collaborators, choose on top menu: > Online > Passcode Manager > Your
Project’s Name > Playback Mode > Restricted Playback

Regular Playback will set security to level 1 (default):
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@ Curren

Project

Generate New Passcode

Prj.id.-1 [Expired) » 156 2016
Project: Shared PSU ( ID: 1341)

Privileges:  Blind : User can't see timelines made by others
Playback Mode V! Playback
R ed Playback
Expires on: 10/4/211:20PM

Generate Cancel

Generate Passcode Remove Passcode Copy Passcode To Clipboard

Note that it is possible to change this setting per user also. To choose level 2 security
for given users either when adding them individually or after they have already
been added, choose on top menu: > Online > Edit Project’s Users > Playback Mode
(Column; double click on user’s row to edit)

Project's Users

Users:

Username | Privileges (Double Click To Edit) | Playback Mode (Double Click To Edit)
brandonemig (o...
rnn2 Can see everything Ranuilar Dlavhark
azaria8 Can see everything v/ Regular Playback
jmccauslandi Can see everything Restricted Playback

New user

Username:

Privileges: Can't see timelines made by other users

Playback Mode: ' Regular Playback

Remove

3. Emphasizes Security at the expense of some convenience
a. V-Note never uploads a video or audio to our servers
b. Thisis a global setting that will apply to all projects and all users as
long as it is set
c. Ifpseudonyms are used, no identifying features of video subjects
are ever shared directly with or by V-Note
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d. All normal V-Note analysis functionality is still maintained as far as:
coding, statistics, transcriptions, etc.

e. Collaboration space still must be used on our servers for metadata
including: transcripts, IRR data, drawings, etc.

f.  When a user opens an online project that employs Level 3 Security,
they will be prompted to browse for the Title: length (e.g.,
SallyTeachingVideo: 55:26 ) on their computer / USB drive / other
locally approved server (such as: university servers / Box / etc. per
your institutions approvals)

Level 3 security can be selected by choosing:

On Mac®: V-Note Pro > Preferences > Storage Settings > Default
Publish Mode

On Windows®: Edit > Settings > Storage Settings > Default Publish
Mode

V-Note Settings

User Interface Settings
Keyboard Settings Video Backup Folder: /Users/brandonemig/Movies/V-Note Video Backup
Overlay Settings
Storage Settings
Playback Settings
Network Settings

Maximum Cache Size: 1024 MBs

Cache status: Online Videos: 680.48 MB
Network Requests: 0.00 MB
Waveform Data: 8.20 MB

VCG Data: 1.62 MB

Default publish mode: v/ Upload video to V-Note's servers
Don't upload video to V-Note's servers

Always Ask
v Enable autosyncfo. _...... . _,-- .-
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AUser Who haS received access @ V-NotePro File Online Edit View Timeine Transcript Playback Tools Help

L ] V-Note Pro 2.7.4.52t [Untitied)}

to a project shared with security &
level 3 enabled, will see the
following screen with a “Browse
To:” button over the video play
window upon opening such a
project each and every time it is
opened. They will need to have
access to the video’s (or audio’s)
storage media to work with the
V-Note Project.

Accessing Online Projects

To access a project for the first time % V-N GLILCY Edit  View Timeline Tran]
via a passcode that has been shared
with you by another V-Note user,
log on to V-Note, then choose from
the “Online” top menu “Join
Project Using Passcode.” You will
be prompted to enter or paste the
code in.

3] Logout

O Publis Djec
&% Edit Project's Users
B Passcode Manager

Join Project Using Passcode

+ Browse Online Projects
{ Refresh Online Project
© Save Changes To Online Project

Once entered, click “Continue,” and you will

open the project and be ready to begin

Enter a passcode: working. You will never need to enter the

' code again. Rather, the project will appear
Continue | | Cancel in your list of online projects accessed in the

manner described below.

8 00 Join Project Using Passcode

If a user has added your username manually to the project, you can access it in your
list of online projects directly, after logging on. More below.
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@ V-NetePro Fle Ovine ESt View Timelse Tansorpt Payteck Tools  Hep m N W F Q@ - NSy 27

To access all your
online projects
including those shared

with you (whether ‘/—ﬁOtG

manually shared or

shared and previously
joined by passcode)
and those you own,

click “Online” from
the screen displayed

when V-Note first g u

opens. A list of projects . St
will appear. Double
CliCk ona prOjeCt to Copyright 2014-2021 V-Noteorg. Al Rights Reserved.

select and open it. You can also sort projects per: upload date, owner, and duration.

Viewing Data from Other Users

Once other users have contributed labeled instances (i.e., codes), transcripts, or
other data to the video, these will appear in the projects of any user that has full
permissions to see them. This can be useful to look for areas of similar/different
interpretations or interest from among video coders at particular times on the
video. Differing opinions on “Excellent” practice or technique will likely differ, for
example. See the following image for an example.

@ V-NotePro File Online Edit View Timeline Transcript Playback Tools Help 4 33 @B N = T Q 8 + MonSep27 12:31
[ ] V-Note Pro 2.7.4.52t [Classroom Data - multiple user classroom data.vnpr] **using APIS2T for APl endpoint**
‘ —
Transcript B8 Q ®© 0
Author Start Duration Speaker

1 brandon  00:00:08.000 7.000s Person

— - ‘ . 2 brandon  00:00:22.000 7.000s Person
= A
>

po=__ 3 brandon  00:00:33.000 1.000s Person
R ]

e
v

1:~\ e

A

5 brandon  00:00:38.000 40005 Person
i 5! 6 brandon  00:00:43.000 7.000s Person

; 4 brandon  00:00:35.000 2000s Person

—
7 brandon  00:00:54000  4.000s Person

8 brandon  00:00:59.000 1.000s Person

9 brandon  00:0%:01.000 3.000s Person

There's a lot of roads that are cut from sedimentary rock, and 10 brandon  00:0105.000  1.000s Person

you can see it if you know what to look for.

00:0%08 000 7000« Pareon

Select Row
Select Time Range
Select All

Play From Here
Jump To Time

Clear All
Select All
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By default, all users’ labeled instances are visible. For a given label and timeline, for
example, “Excellent” (e), each user’s labeled instances will appear in the same
timeline and in approximately the same color. Colors lighten as one goes down
screen to aid in differentiating users’ data. Hovering the mouse over any labeled
instance for a second or so will reveal its author.

Right clicking over any timelines-area white :
Show Only Owner's Labels

L o« ” L] - -
space and selecting “Authors” will provide a S Shou ol

3 ) elec ime rRange
list of all users and allow one or _more users Select Al Yy S —
data to be toggled on and off of view. A +/ marlenab (empty)

h k k . d h ) d . Play From Here v/ matthew (empty)
checkmark indicates that a user’s data is Jump To Time e T
displayed- Auto transcribe [test] v mdlan;nmi (?7 instances)

Start Playback V/ nandipatiraju (empty)
v/ nanorma3 (empty)
Similarly, transcripts added by other users Autors B //nafahrer(27Instances)

can be toggled off of view with a similar
checklist of users. This can be accessed by
right-clicking over the transcripts anywhere.
Users’ transcripts are visible if his or her
name is checked.

v rlime08 (16 instances)
v sglimcher (27 instances)
V/ zackery1 (57 instances)

Clear All
Select All

Saving and Publishing Projects Locally and Online

You can save V-Note projects locally only or online and locally. You can use the
shortcut buttons on the top blue bar or the File and Online Menus.

To save locally (e.g., to

your hard-drive or local

media), you can click on A/
the disk icon in the blue
bar. Alternatively, you can go through the menus as follows: File > Save Project (As).
Either way, if you have not yet provided a title, you will be asked to input one and
select a folder to save in.

If you would like to publish a project online for storage or for sharing, you can
click the “cloud” button or go through menus: Online > Publish Project. If your
project is already published to V-Note’s Collaboration Space and you are logged on,
all your changes will be published automatically to our servers and made
available in real-time to other collaborators. Likewise, if others make updates
online while you are working, these will appear automatically. If you do not wish to
see these, you can choose to view only your own timelines from view by right
clicking over the blank space anywhere on the timelines and choosing: > Authors.
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Chapter 4: Movie Builder

What is Movie Builder?

Movie Builder, at the bottom of the V-Note screen, is the place where labeled
instances become

clips. For
example, if [Fiying Squir ][]
“symbiosis” were [interesting |Il
given a label (and [ Symbiosis ||| | - | &
timeline), and [ Truffles || | | /(
every time [ Trees | ] / /
symbiosis [Rainforest || | / [ ]
occurred in the
. . | Water |
video, the instance [ e ]
were labeled. all Lead time - open: e close: [Xl a
these labeled Movie Builder 0 “
instances would be > H-
aggregated B Export Video Symbiosis
automatically at

the bottom on the “symbiosis” tab. To click the play button there would play only
instances labeled as symbiosis; no other parts of the video would play.

Navigating Tabs

Other tabs work similarly. All tabs bear the same names as the labels above to the
left of the timelines. When a tab is clicked it reveals all the labeled instances - now
clips to be played - placed side by side without the parts of video between them.
Custom Movie Builder Tabs

The “Custom 1” tab (and subsequent optional added custom tabs) work differently.
These are blank by default, but they can accept labeled instances to be dragged in
from any timeline. These can then be reordered once dragged in.

Playing Videos in Movie Builder

The Movie Builder allows you to rapidly play, scan, and compare clips from a given
category or label. It also allows you to make and export new videos from these clips.
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The Play button (triangle) to the left of the Movie Builder can start and stop the play
of clips on a given tab. A double click at any point over the labeled instances in the
Movie Builder can bring the play head immediately to that point.

During Movie-Builder play, other functions, such as labeling, using the timelines
above, and transcription are disabled until Movie Builder play is stopped.

Any given instance playing in the movie builder is also highlighted above in the
timelines so it can be identified in its original context.

Exporting Videos

Exporting video from Movie Builder
To export a video, select the onct oesrpton ots
tab you want or arrange a Segment: 00:24:30 - 00:27:40 (Lynx)

Duration: 00:03:10.715

custom tab as you would
like, then click the “Export
Video” to the left of the
tabs. Browse to a folder
where you would like to
save the new video and give
the video a title. Next, you
can choose to export ¥ Export transcripts as subtitles (.srt)
transcripts separately Subtitles File: /Users/brandonremig/Desktop/RabbitClips.srt
and/or overlay on the video
the timestamp and name of
the project from which it was taken.

Export Mode  Export Both Video And Audio Streams (WEBM file)

Output File: /Us I < top/RabbitClips. webm

Output Video Resolution: | 640x360 (16:9) [input resolution] <

v Show information about each clip as overlay when clip starts

Overlay Duration: 2secs |

Export Close

This can take some time depending on your computer. The processing time should
not normally exceed the total time of the video clips for most computers. A progress
bar can be viewed at any time. This may vary depending on your processor speed
and other processes your computer is performing. You can use V-Note while this
process is occurring in the background, or you can use your computer for other
things, although this may increase time required to export the video.

The output video format is .webm (also called .vp8). This is a commonly
supported format and should play without problem on a current web browser as
well as on other media players. Due to licensing restrictions we are currently unable
to offer output to other formats.

Should you desire a video in another format, such as .mp4 or .mov, numerous

products exist, many of them free, that can convert .webm to other video formats
such as .mp4, for example. A free application called VLC is one such application.
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Exporting PDF Screenshots

V-Note allows you to export screenshots as a PDF. In order to use this feature, first
add the instances you would like screenshots of to the
Movie Builder or Multi-Project Tab. Next, choose Movie Builder
“PDF” from the bottom left (see image). You will then | D> ]
be prompted to choose the frequency of the I
screenshots you would like from each video segment.
You can get a frame from every .05 seconds to every
10 seconds (see image below).

Finally, you are able to choose the orientation

0.05 .
: et (portrait or landscape) and arrangement
video Fram 0,20 secs (number of columns, rows, and margins) as
0.50 secs . .
Select Frames Interv: NS shown in the image below of the screenshots.
LY You can also preview the pages by scrolling

10.00 secs OK

through them at the top. When arranged as you
like, click “Export to PDF” and you will have a PDF of your screenshots.

Output Settings
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Chapter 5: The Multi-Project Workshop

What is the Multi-Project Workshop Tab?

The Multi-Project Workshop has been redesigned as of version 3.0 of V-Note. It is
now incorporated into the Movie Builder function and works like it for easier and
more logical use. Unlike the Movie-Builder, the Multi-Project Workshop allows for
the creation of videos with clips from multiple V-Note projects. For example,
over a whole semester of teaching videos - even if each video is in a separate project
- each question asked can be put into a single place for review and made into one
video for export using the Multi-Project Workshop. The Multi-Project Tab also
allows two video clips to be played at the same time. It also allows for the
creation of screenshots on PDF with customizable size, columns, and rows of
screenshots.

Adding Clips to the Multi-Project Workshop —

Copy To...

Cozz Description Notes
There are two ways to add instances to the Multi- Edit

Delete
Reopen segment

Project Workshop. With an open project containing
labeled instances, simply right-click on one that you
would like to add to the Multi-Project Workshop.

Then, choose “Add to Multi-Project Workshop.” You

Tags [

Add to Multi-Project Workshop

can also Drag-&-Drop segments and arrange them. EEIZEI ?ﬁ:ve Range
The clip will be placed in the Multi-Project Workshop Select Al
Tab at the right of the Movie Builder. A red number s i

Jump To Time

will appear representing the number of clips (i.e.,
labeled instances) that have been placed into the
Multi-Project Workshop. This can be seen in the image below.

Pause Playback

The contents of the
Multi-Project

Workshop can be
viewed any time by
clicking on its tab Movie Builder 0
« ) 1 BBC Forest
labeled “Multi”. The @ 00:04:37 - 00:05:09 (In
clips are shown, with ¢ Interesting

their respective
original project’s title, the time location in original video, and original label applied.
No thumbnails are available. Even when V-Note is closed and reopened with
another project, these instances will stay in this tab. This is not true of other taps,
which are project specific.
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Exporting a Video from the Multi-Project Workshop

The clips can be dragged left and right to the desired order. Once in order, they can
be exported in similar fashion to the clips in the Movie-Builder described earlier in
this chapter. One difference is that, given the varied origins of the clips, their
original project’s name and the time at which the clip was taken can be displayed at
the beginning of each respective clip. This option can be toggled on or off with the
check box at “Show information about each clip as overlay when clip starts.”
Overlay duration can also be modified. Default display is for 2 seconds.

Note that in order to export a video, the media on which all included clips’ original
media is stored must be connected (e.g., external drive, internet and log on - if online
projects are involved). These projects will be accessed to provide the clips.

B8C Forest
00:04:37 - 00:05:09 (In

Student Resp

Playing Multiple Clips at One Time

Playing up to four clips simultaneously, even at different speeds and at different
volumes (or muted) can also be done by clicking the four-box icon on the right as
shown below. Then, drag the desired clips text into the one of the four video play
windows in which you would like it to play. Play controls (same as main) will

appear_ o0 V-Note Pro 3.0.0.52t [Teaching Video Sample - Teaching Video Sample.vnpr]
. \J Tesching Video Sample
The size  |u— R — [ .
of the I | S = !
window | b= ( =%

can also - S E

be
increased Drag and drop

segments here
or

decreased by dragging the play window’s edges. You can also toggle off the regular
play window and timelines, etc. for more viewing area. Note that in order to have
multiple entire videos (camera angles in parallel, consecutive videos in series, etc.,
in a given project, this is a different function; simply drag the videos into the main
play-window or choose >> File >> Edit Playback Sources to manage these.

Note that in order to play multiple clips, the media on which both included clips’
original project is stored must be connected (e.g., external drive, internet - if online
project, etc.). These projects will need to be accessed by the program to provide the
clips.
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Chapter 6: Transcribing and Automatically Coding

If you would like to add transcripts and captions to your video, V-Note is well
equipped. One of our most important goals with V-Note was to make transcribing
easier. V-Note allows you to use automatic artificial-intelligence-based on-device
transcription. Or you can transcribe manually using looping, a constant replay of
usually about 5 seconds (you can adjust this) while advancing through the video by

shifting it to the right
about 2 seconds (also
adjustable). V-Note also
helps you to create
organized, timeline
related, transcripts and
assigning utterances to
speakers.

The automatic
transcription function
can be used by right-
clicking over any white
space in the timelines
area or over any labeled
instance. From this menu
you can choose
“AutoTranscribe

Copy To...

Copy Description Notes
Edit

Delete

Reopen segment

Tags >

Add to Multi-Project Workshop

Select Row
Select Time Range
Select All

Start Playback
Play From Here
Jump To Time

Preview in...

AutoTranscribe Selection

AutoTranscribe Entire Video

Blur Faces in Selection
Blur Faces Over Entire Video

Remove Blurring in Selection
Remove All Blurring

Selection” or “AutoTranscribe Entire Video”. Once selected, you will be offered two
choices. You can choose “Highest Quality” which will take about 3-4 times longer
than the “Fast” version. The fast version is usually very good for professionally
produced media such as: television, radio, formal speech, interviews, etc. It may or
may not have good performance with conversation speech depending on factors
such as: background noise, overlapping speech, unfinished utterances and the like.

AutoTranscribe Dialog

Video File: Detective Stabler's Fiery Interrogation of Teenage Arsonist Law and Order Special Victims Unit.
Start Time: 00:00:00
End Time: 00:05:19

s

Mode v Fast ( suitable for television, radio, formal speech )
HMM(M&MM“MWWWWB
Input Language: = English (en) ¢

Transcription takes place entirely on your device. As such, a package for this
transcription will need to be downloaded to your computer. The fast package is
about 90MB. The high quality package is about 3GB. You may choose both or either
and change this at any time.
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Speed of transcription will vary greatly depending on
a few factors, the most important of which is your
computer’s specifications including: RAM, processor
speed, operating system, and related factors. Once
begun, the transcription can take from about 20% of
the time of video duration (when played at regular
speed) to 10X or more of the normal duration.

You can always change or correct your automatic
transcriptions once made.

Once processed, you can modify the presentation of
your transcripts in a variety of ways. It is possible to
change the: presence or absence or punctuation; the
speaker name (note automatic diarization, or
detection and assignment of speakers) is not yet
supported; we expect to add this as its performance
improves); maximum characters allowed per line or
utterance; maximum duration for an utterance;
maximum pause length between two words before
breaking an utterance into multiples.

Automatic Coding from Transcripts

Speaker Options

Set Speaker To:

Grouping Options

« Show punctuation

Open offset:

10.000 s
Close offset:

0.000s
Min Duration:

11.000 s

Split Utterance By...
« Punctuation:
o7
Max characters:
60 chars
+ Max duration:

15s

Max pause between two words:

0.001s

It is possible to generate your labeled instances (aka codes) from your transcripts
automatically - regardless of how they were created (manually, automatically, or

imported).

To do this, choose the “Magnifying Glass” Icon on the right, which represents the

Project Overview. Next, type a word or phrase in the bar near the top.

Project Overview fire

Start -
00:00:26.240
00:00:46.880
00:00:53.740
00:00:59.300
00:0%:06.140
00:02:58.660
00:03:04.900
00:04:53.6560
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End
00:00:28.120
00:00:50.100
00:00:55.200
00:0%01.140
00:0%10.140
00:03:02.260
00:03:08.570
00:04:56.780

You're running like your pants are on fire

! |
Hosstthef SUectA

Locate
Bt Why 88t sy from here

Because Mil  Create Labeled Instances On Timeline From Utterances
So you've got a perv who likes to play with fire and little girls.

*I'm going to set a fire to send her a message. *

You gotta think for fire,

I set that fire.

Label: Label 1
Label: Label 2
Label: Label 3

Label: Lal'»l 4
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All utterances will be displayed just below. You can then click over one or CTRL-
Click to select multiple. Then, right-click to “Create Labeled Instances on Timeline
from Utterances.” These will be created on the timeline of your choosing.

Turning On Manual Transcription

To turn on transcribing click the check boxes called “Enable Transcription” found in
the upper left of the transcription window.

Transcript -] b4 * TEL
| Durption| Spehker| Text

8s Ken When you thavel round the |d every education system on Earthfhas thejsame Hierarch
6s Ken At the top are Rpathematics and la ages...then the humanities, pnd at the bottogh are tr
8s Ken And in pretty mudp every system,too,therg a heirarchy within the arts. firt and rpusic ar

Search
Transcripts

Enable Toggle Loop Begin & End
Transcription Looping Back & Fwd Utterance Export

Show Transcripts

Ti A
as Subtitles rans

Transcribing

Starting and Stopping Utterances
To transcribe, find a place you would
like to transcribe in the video. Starting : CTRL + Shift + Enter
Anywhere is fine (you can do earlieror | Stopping: CTRL + Shift + Enter
later sections at any time and they will
be put in the correct order and Note: on a Mac command replaces CTRL.
associated with the video timeline as

well). Drag the playhead to this place. Change this or any shortcut keys; See Ch. 1

Once you find the first utterance you would like to transcribe, click “Toggle
Looping.” Wait until the red line (i.e., playhead) comes to just before your utterance,
then, press CTRL + Shift + Enter (on a Mac command replaces CTRL). The utterance
time will be marked by the position/time the playhead is at when you press CTRL +
Shift + Enter. You can now begin typing the name of the speaker (blue below) and
what you hear to make your first utterance on the transcript (red below).
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Using Looping

Looping will repeat-play a short section of [ Flying Squir |[T7]
video outlined in yellow - by default about 6 [ crzzy ]
seconds - over and over again. This is to give [ e |

[ Hae [ ]

you time to type what you hear, as speaking
speed usually exceeds typing speed. As you [interesting ]Il

complete typing the speech contained within [ abel1 ]
your 6 seconds and wish to continue you can [ unx |

advance the loop and [ Predator [ |

continue transcribing by
' . hitting the CTRL + Shift + Advancing the Loop

> keys all at the same

time (note: on a Mac the CTRL key is _ .
replaced by the “command” key). In fact, Forward : CTRL + Shift +

you can also back up the loop on the
timeline by hitting CTRL + Shift + < (again, | Backward : CTRL + Shift + '

the “command” key replacing CTRL on a
Mac)_ Note: on a Mac command replaces CTRL.

h hi h keys;
Once you come to the end of your gh.a:\ge this or any shortcut keys; See

utterance (either by advancing or not),
press CTRL + Shift + Enter once again to
end the utterance. The utterance end time will be marked by the position of the
playhead (not the loop) when pressed.

Advance the loop (CTRL + Shift + >) if necessary to find the beginning of your next
utterance and repeat the steps outlined above.

Changing Loop Duration and Advance

You can change the length of the audio loop from 6
seconds to a value of your choice in the “Loop Duration” L a
setting at the top of the transcription window. Loop Duration: |31 6
Similarly, the “Advance By” setting changes the time of
loop-advance (the same time also applies to the backing up).
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Manually Adjusting Start and Stop Times of Utterances
I

or start ouation ¢ 'TO adjust the start time of an utterance after you have made
on | 00:00:24.274 9s cuy it, simply click in the box indicating it’s time (see left)
where you can use the arrows to adjust the time or simply

on |00:00:33.889 9 s | Guy . .
type 1n a new time.

on 00:00:43.31&l:] 95| Guy
on | 00:00:52.797 2 s | Guy

Reordering Utterances on a Transcript

You cannot drag an utterance up and down to reorder, as their order is determined
automatically by their start times. If you would like to reorder utterances that are in
close succession, you must adjust their times manually in this fashion. New
utterances, even if between existing utterances, will also be placed in their proper
order based on start time.

Importing Transcripts from Other Sources

V-Note allows for the importing of
transcripts from most other sources.
These files must be in the format CSV
(comma separated variables), XLS
(Microsoft ® Excel ®) or SRT (a
commonly used subtitle format). If you
do not have your transcripts in these
formats, you can usually make a suitable CSV or XLS file type for import in a
program such as Microsoft ® Excel ® or similar spreadsheets.

Once you have your file with your transcripts, V-Note can import the file and will
automatically associate the time with the video. If the times do not agree (for
example, if you removed the first 20 minutes of video), you will need to modify your
transcripts in a spreadsheet program. For example, subtract a time (20 minutes in
the example from each utterance’s start time and end time so that it aligns properly
with the video in V-Note, for analysis and subtitle display purposes. Fortunately,
spreadsheet programs such as Excel ® can make this easy and automatic by
allowing you to apply a formula to the whole column. Consult the program’s
respective user manual for more information.
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In order to begin the importing of the transcripts, click the button labeled “Import
Transcript” in the transcription window near the top of the screen. This will allow
you to browse for the file. Once you find it, double click it and it will prompt the

Import Transcript —

Import Transcript Dialog

Dialog as shown Input Data: .
- 1 2 3 Data type Column Index
below V NOte 1 00:37:29:45 | Mark Anybody have any questions on that one? (4 s)" *Utterance Start: 1](4)
1 2 00:38:15:77 | Mark Think about your simple machines.. Things that n
attempts to aSSlgn Haa. L P 9 Utterance End: 0|+
3 00:38:23:63 V Mark can | go the bathroom? T
the Columns 4 00:38:27:04  Mark Yeah Utterance Duration: 0 \;\
5 00:38:45:48 | Brandon | Sorry (placement of wheel and axle) n
*Speaker: 2|5
Correctly and 6  00:38:50:59 L Thanks ?
: 7 1 00:38:51:10 | S That's OK Text:| 3117
prOVIde a Sample 8 00:38:51:67 | Brandon | It's more for looks. It falls apart. But.. you canu
1 9 00:38:54:56 | L That was really bothering me (weight swinging).
I‘enderll‘lg Called a oo - Refresh Preview
« . ] . .
preview” which is Preview:
shown at bottom of st End___| Speaker Text

1 00:37:29.044 | 00:37:36.044 | Mark Anybody have any questions on that one? (4 s) You did well. That one t.
2 00:38:15.076 | 00:38:22.062 | Mark Think about your simple machines.. Things that come up over and over ;
3 00:38:23.062 | 00:38:26.003 |V Mark can | go the bathroom?

4 00:38:27.003 | 00:38:34.003 | Mark Yeah

5 00:38:45.048 | 00:38:49.059 | Brandon | Sorry (placement of wheel and axle)

6

7

8

9

the window.

In the event that V-
Note does not
produce the
“PreVieW" you 10 00:38:56.099 | 00:38:57.099 M oK

desire, you can e —

assign the columns Cancel | (I
manually (upper right of window). “Refresh Preview” will allow you to see how
your data, as chosen, will look in V-Note once imported.

00:38:50.059 | 00:38:51.059 | L Thanks

00:38:51.010 | 00:38:52.010 | S That's OK

00:38:51.066 | 00:38:53.055 | Brandon | It's more for looks. It falls apart. But.. you can use it if you need to
00:38:54.055 | 00:38:55.099 | L That was really bothering me (weight swinging)..

If you are still unable to import your transcript, you may need to reduce the quantity
of extraneous (non-transcript) content in your files and/or verify continuous
columns and rows of data.

Exporting Transcripts

V-Note can also export transcripts. There are two ways to accomplish this: alone or
with timeline labeled data (i.e., codes). Exporting transcripts alone will be discussed
in this section. Exporting them with data will be discussed in the next section.

In order to export transcripts, simply click on the “Export Transcript”

button near the top right of the screen. Browse to a folder where you !.,'
would like to save the file. Create a title. Finally click “Save.” The file

will be saved as a CSV, SRT, or XLS file. XLS and CSV-type files can be opened by
Excel ® or other spreadsheet programs or imported by V-Note again. SRT-type files
can be opened by traditional video players such as VLC. SRT-type can also be
imported into V-Note.
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Chapter 7: Raw Data Export

Exporting Raw Data

Raw data including: labeled instances, notes, and transcripts can be exported from
V-Note for use in other programs (e.g., spreadsheets, word processors, email, etc.).

File Online Edit View Timeling

New Project
Open Project
Recent Projects
Save Project
Save Project As...
Close Project

Export Movie Builder Video

Export Histogram
Export Raw Data

Overlap Statistics
Nested Statistics
Boolean

Project Details

Close Application

You can export: linear table data; instance by
instance; or instance by instance with multiple
projects. Linear table data will be shown first.

To export linear table data from V-Note, choose:
>File > Export Raw Data. You will have three
options including:

1.Interval for data rendering (from 1s- 60s)

2.To include transcripts

3.To include description notes (typed into
labeled instances)

Export Linear Table Data
Export Instance By Instance

Export Instance By Instance (Multiple Projects)

Once you have navigated to the folder where you
will save and created a title, click “Save.” Your file
will be output as a CSV, which can be opened in

spreadsheet programs such as Excel ®.

Selecting an Interval for Your Data

Selecting an interval for rendering your

data, will be like selecting a finer or coarser o Export Raw Data Dialog
resolution. A 1-hour video rendered at 1 Interval Z N ¢ |

second intervals, for example, will have Output: ioss i [=]
3600 lines of data (60 seconds x 60 minutes Mincly 155 on

= 3600 seconds) and will take many pages @indd 20 Notes

to print; whereas, that same 1-hour video, il (Cancel | [ oK

rendered at 60 second intervals, would

have only 60 lines of data.
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A sample set of the linear table data rendered at 5-second intervals.

O awN

~

Label Name:
Label Number:
Labeler Name:
Labeler Number:

Total time:

8 |Percent of Video:

9

10 Time

1n
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
35
36
37
38
39

The same data rendered at 20 second intervals.

10 Time

Instances.
Total time:
Percent of Video:

0:00:00
0:00:01
0:00:02
0:00:03
0:00:04
0:00:05
0:00:06
0:00:07
0:00:08
0:00:09
0:00:10
0:00:11
0:00:12
0:00:13
0:00:14
0:00:15
0:00:16
0:00:17
0:00:18
0:00:19
0:00:20
0:00:21
0:00:22
0:00:23
0:00:24
0:00:25
0:00:26
0:00:27
0:00:28

abel Name interesting

Latal Number
Labeler Name
Labeler Number:

0:0000
0:00:20
0:00:40
0:01.00
00120
0:01:40
0:0200
0:0220
0:02:40
0:03.00
0:03:20
0:03:40
0:04:00
0:0420
0:04:40
0:0500
0:05:20
0:05:40
0:06:00
0:06:20
0:06:40
0:07.00
00720
0:07:40

[ NI

F
Student Resj

0:02:05
14.85%

013

00103, 0007

007
003

018

Teacher Res|
4

1

21
0:02:28
17.60%

Person

Person

Teacher Res|
4

1

n
00228
17.60%

Person
Person
Person
Person
Person
1 0:03 Person
Person
1 0:04 Person
1 0:07 Person
2 0:03 Person
Person
Person
Person
2 00:02,00:04 Person
Person
Person
Person
Person
1 0:02 Person
1 0:02 Person
Person
Person
Person
3 00:04, 00:03, Person

Al right, let me show you something from yesterday.

Given enough time, and enough... depth, what's gonna happen to the sediments?

All ight, let me show you something from yesterday.

Given enoug, Person
Now f- how Person
Well, you're Person
But my ques Person
What's that, Person
Uke that?  Person
Saythat.  Person
What éid the Person
Otay, but wh Person
and in canyo Person
Sorry. Person
What do you Person
That's right. Person
1'd love 10 pa Person
You &d good Person

What's goon Person  It's gonra bePerson  That's good,

What's (ithaPerson  You have deposition.

Yeah Person  And,youknoPerscn  Yeah Person  You know,
There's a lot of roads that are cut from sedimentary rock, and you can see it if you know w
When it- cer Person O, Perscn  Let's see

Yeah Person  Yeah Person  Now, how dcPencn  Because it
Because lt's Person  Okay.That's Peron M. Person  That'swhe
(inaudible) nPerscn  That's good. You know, the weed- that's a good word. Another v
We didthis. Perscn  Rcutsintoit Person  That's right. So here's a wonderful @
Suppose- and this was cur ttie model from yesterday- suppose when the sediments got ¢
Suppose- suPerson S0 now we have an animal, you know, that could have been bur
Rudy, whatcPerson  It's gonna blend into the rocks, with the rest of the sedments.
What'sthat, Person  Becomes fosPerson  That's good. Very good.
SollijustcoPerson  Ukeit Peson  Huh?

Suppose we dig down further into the secimentary rock, into a layer that's underneath it

Maybe- maybe this fossil of a fish Is found In here, and maybe something like this-

is found bel Person
which weuld Perscn
Why is the b Person
$oit's almos Person
Don't laugh. Person
Al right. Ary Person
e Person

What is that Person Well, it's called a brachiopod. And to us it locks ke a dam. It's

TheoneattiPerscn  Which wouk Person U Persco  What weu
Because it's Person That's right. Person  Sol-socbvicPerscn  Now, yout
Al right. Now, let me show you something. Let me shut this, Corey, you want to get the I
oh Perscn  Sonia,Itold Perscn 1 love your pants. Loving It

s Perscn  Anyidea? Perscn  Yeahum. Peson Wl | dor

No. It's nct i Person s a. Person Sonia? Perscn i itamou

Although it is the same data, the 20-second interval rendering takes up much less
vertical space. All resolutions will include the percentages of the video taken up
by each code at the top. Additional authors (i.e., coders), if present, will appear to
the right for easy comparison as well (not shown above). No labeled instances are
omitted regardless of resolution. If a labeled instance is present, even for a fraction
of a second during an interval, it will be shown on any output data, even at intervals
of a minute. The actual duration may be noted to the right (per your output settings)
but a smaller interval allows for better determining of durations of labeled instances
visually but increased the file’s size vertically.
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Similarly, all transcripts are displayed regardless of interval. If, in a 1-minute
interval rendering, multiple utterances appear during that minute, they will be
stacked left to right, superimposed, if need be; whereas they would be stacked
vertically read without expanding the cell in a smaller interval rendering such as 1-
second. You will need to balance the concerns of a high vs. low interval
resolution for your data based upon your needs.

Including Transcripts and Other Options in Raw Linear Table Data

The transcripts, shown to the
right of the spreadsheet’s raw
data, can be included by checking
the check box “Include
Transcription.” Viewing Output:
transcripts and labeled instances
side by side in a spreadsheet can
be helpful in visualizing how they
relate to one another. Include Description Notes

Export Raw Data Dialog

A

Interval: 1s < Edit Intervals

Include Drawings Label

Include Transcription

Include Segment Duration
Similarly, the description notes

(i.e., what is typed in a labeled Advanced... Cancel
instance), can also be toggled off.
No description notes are present in the samples above. The “Include Drawings
Label” option will include labeled instances wherever drawings occur (31s-54s, for
example).
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Exporting Data Instance by Instance

Depending on your analysis and your goals, you may want to export your data in an
instance by instance format. This looks different from the linear table data and will
provide each instance in its own row along with its associated data.

1

2 Project

3 Teaching Video Sample
4 Teaching Video Sample
S Teaching Video Sample
6 Teaching Video Sample
7 Teaching Video Sample
8 Teaching Video Sample
9 Teaching Video Sample
10 Teaching Video Sample
11 Teaching Video Sample
12 Teaching Video Sample
13 Teaching Video Sample
14 ITeaduru Video Sample
15 Teaching Video Sample
16 Teaching Video Sample
17 Teaching Video Sample
18 Teaching Video Sample
19 Teaching Video Sample
20 Teaching Video Sample
21 Teaching Video Sample
22 Teaching Video Sample
23 Teaching Video Sample
24 Teaching Video Sample
25 Teaching Video Sample
26 Teaching Video Sample
27 Teaching Video Sample
28 Teaching Video Sample
29 Teaching Video Sample
30 Teaching Video Sample
31 Teaching Video Sample
32 Teaching Video Sample
33 Teaching Video Sample
34 Teaching Video Sample

48

End
00:00:06
00:00:23
00:00:34
00:00:39
00:00:41
00:00:51
00:00:57
00:00:57
00:01:03
00:01:44
00:01:35

00:01:51
00:01:52
00:02:20
00:02:25
00:02:29
00:02:55
00:02:59
00:03:04
00:03:10
00:03:16
00:03:17
00:04:13
00:04:24
00:04:27
00:04:34
00:04:36
00:04:37
00:06:17
00:06:12
00:06:19

Duration  Label
00:00:04 Interesting
00:00:05 Interesting
00:00:13 Question
00:00:03 Student Resp
00:00:03 Interesting
00:00:07 Question
00:00:03 Question
00:00:03 Interesting
00:00:04 Student Resp
00:00:36 Interesting
00:00:07 Question
00:00:03 Question
00:00:03 Student Resp
00:00:03 Teacher Resp
00:00:16 Question
00:00:05 Student Resp
00:00:04 Teacher Resp
00:00:18 Question
00:00:04 Student Resp
00:00:07 Teacher Resp
00:00:08 Question
00:00:03 Student Resp
00:00:03 Teacher Resp
00:00:15 Question
00:00:08 Student Resp
00:00:04 Teacher Resp
00:00:10 Question
00:00:04 Student Resp
00:00:02 Teacher Resp
00:00:57 Question
00:00:06 Student Resp
00:00:04 Student Resp

F G

Parent

OO0 0000000000000 000000O0O000000O0O0O0

H

Level Code Segment Index

DDPO ADO A DD A DD A DO A DO A DOPO PO 2O -

Tags
Color __ Desc Author
[ sl Notes go here

2

How to ID sedimentary rock?

8
g
|
g

Redirection

v s n

w
3
3
3
8

[
3
3
3
8

w S
3
3
3
8

o.mnw
“II
3
3
g

~
-
-
3

FOO

[
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Chapter 8: Synchronizing Secondary Audio

You may sometimes need to add a secondary audio track to a video. This may be in
case of a camera location that is far from a speaker and does not have adequate
sound quality. A closer voice recorder can generate clearer audio. Fortunately, V-
Note makes adding a secondary sound track easier, and in many cases, automatic.

Once added, these tracks can be played at the same time with video playback, or one
or the other, or at different volumes with both being audible but one being
dominant.

For best results, the tracks should be similar. The computer will look for similarities
in sounds and match them up according to time. They must have been recorded at
the same event and have similar start and stop times.

V-Note can even correct for drift, which can occur when devices (i.e., camera and
external audio recorder) record at slightly different rates. This normally results in
audio that is synchronized early on in the video but becomes out of sync as the video

plays.

Adding Secondary Audio Tracks

In order to add a secondary audibo, Fie Online Edt View Timeine Tanscript Ployback | Tools | Help
first, add the video to the play gyl () ) G Y Ao Tk
window as described in Chapter 1 of Y e
this manual. Next, simply drag the ) Fansiation Edter
audio track you wish to synchronize ' < : Comulste Crach
to the video play window where the
video is displaying. Alternatively,
you can click on the “Tools” top
menu and select “Add Audio Track.”

Open Backup Folder

Automatically Synchronizing Secondary Audio Tracks

Once you have added your audio track to your video, you may have to wait a few
minutes while the data in the audio files is decoded; a progress bar appears. When
decoding is finished, you will see a new window pop up like that on the next page.
Displayed on the top white bar is the wave form for the video (i.e., the original audio
track in the same file as the video). This is a representation of the audio track made
by graphing volume across time. In the middle white bar is the wave form for the
secondary audio track, or the one recorded by an external recorder. This is the new
audio track (from, for example, a voice recorder or external microphone) that is to
be associated with the video track and synchronized to its audio.
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Add audio track with manual sync = = “

W-note

| ———

|
Add Markers Align Track View: Don't align v

| ———

)
]
o

Keep aligned with primary track

Cancel

If your tracks have been recorded at approximately the same time at the same event,
you can try to automatically synchronize them, by hitting the “Auto Sync” button at
the top right. This will cause the computer to look for similarities between the two
tracks and shift the secondary track left and right as needed to align the two. Once
done, the third white space (the o 33 5 Gack Witk el e o N
bottom one) will display a A~note
waveform also. This space will ] S—
display the secondary track (the E%“-' y r| - ‘W

same one as in middle white

Acd Marters Mg Track View: | Oon't son

space), but it will be aligned to the . - ; . —
video. You can play them both at WWWWW
the same time by clicking either ! ‘

play button (top or bottom), and ——)
both will play at the same time. A E- MMW“
double-click over the bottom track M= ‘

will bring the play head to the e e ey ek
same respective position in both

and begin play in both the top and bottom.

Aoply Cancel
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Once you have verified your tracks have been synchronized, simply press the
“Apply” button at the bottom of the window. Your secondary audio track will then
be added to the video file and the V-Note project. A copy of your original video will
be saved for backup in the backup folder that will be displayed at the end of the
process. You can also access any backups made at any time by selecting under
“Tools” > “Open Backup Folder.”

If your tracks are dissimilar (e.g., overlaid commentary, an announcer calling a
game, an audio recorder that was too far away, etc.) pressing the “Auto Sync” button
will prompt no action, and the tracks will remain unchanged. The computer cannot
find (enough) instances that are the same in order to line up the tracks. You can still
synchronize them; however, this will be a manual process, as described in the
next section.

Manually Synchronizing Secondary Audio Tracks

If you are not able to automatically synchronize your tracks, you can synchronize
them using V-Note’s manual synchronizing features.

Add audio track with manual sync - o IEN

V-note

— | ————

Add Markers Align Track View: Don't align v

Align Marker(s) Keep aligned with primary track

Cancel
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As with the automatic synchronization option, add your audio track to the project by
dragging and dropping or by file menu (Tools > Add Audio Track). Once added, the
same window appears. This time, however, you will need to select “Add Markers.”

Once this is done, two red lines (both labeled A) will appear over each waveform (as
shown). These are the “A” markers. These can be played with their respective
buttons. Through listening to both tracks and by looking at the waveforms (you can
also zoom in with the slider bar), you should try to find a common point on the
soundtrack (e.g., a clap, a cough, a hit, a run, a score, etc.). Once this is done, you can
drag both “A” markers to the common points on each’s soundtrack. Do not worry
that this be perfect.

You can fine tune it using the “Fine Tune” feature, which lets you loop (play again
and again) the 5 seconds around the point you chose and nudge (offset) the tracks
left and right while listening to both to ensure a good sync. Also, the correlation of
the tracks will increase as they are nearer to being in sync.

Once the tracks sound in sync to you, hit the “Apply” button and the markers will be
fixed. Next, exit the “Fine Tune” dialogue. Finally, click the “Align Markers” button
and the tracks will be brought into synchronization at the point of the markers.

Add audio track with manual sync -

o
A~nolke e

) Fine Tune ? “
|

Add Markers Align Track View: O Loop duration: 5.05 =
T ary aur : . Volume #1: 100 % .

Volume #2: 1.00 ' =

Offset: < -19.86% 5| >

Auto Refine

Correlation: 43% -

D
Apply Cancel

Align Marker (s) V| Keep aligned with primary track

Cancel

After “Align Markers” is pressed, the second track is added to the bottom row and
shifted such that the two “A” markers now align. Playing the bottom one will also
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play the top one at the same time. If done well, the two tracks will play in
synchrony.

It is important to verify synchronicity at several spots during the video, however, as
devices can record at slightly different rates resulting in a track that is in sync early
become out of sync later in the track.

To fix drift, in the event there is some, you can add another marker (or many, in the
event of very irregular recording speeds) to a new space in the secondary audio
track (middle waveform) and repeat the steps outlined above. This will slightly
stretch or compress the secondary waveform between the markers to ensure
synchronicity with the primary audio track.
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Chapter 9: Drawing on Your Videos

Drawing on your videos can be a good way to record and share information about
them. V-Note allows you to draw in real time on a playing video and then play that
drawing back as it was made. The drawing is remade as the video is played again.

You can also share these drawings with others via our storage and streaming
services. They are automatically uploaded when you publish your project online
and can be shared with others in the same manner as transcripts and timeline data.

Using Drawing Controls

To turn on drawing controls press the pen icon in the blue bar above the video play
window. The tools will appear as shown below. You can choose the pen size and
the color on the left side of the toolbar. On the right, the [x] allows you to clear the
current drawing from the current frame going forward and the lets you clear
all drawings you have made. Drawings of other collaborators, if present, will
be unaffected.

The squiggly line allows you to check which user’s drawings are displayed. Only one
user’s drawings can be displayed at a time.
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Adding Drawings to Your Videos

In order to draw on your video select a pen, rectangle, circle, or arrow and a
color. Move the mouse cursor over the video to the spot where you would like to
begin drawing. Hold down the right mouse button and begin to move the mouse.
You are now drawing. When you release the mouse button, you can move to another
spot without drawing. You can begin drawing over the video at any time.

The video can be playing or paused when you draw. If the video is paused, your
drawing will appear in its entirety on that frame when the video is replayed.

If, however, you draw on your video while the video is playing, it will reappear that
way; this means: it will be redrawn on the video as it was made the first time for
all future plays.

In order to erase the screen going forward, while still keeping your drawings in the
past, you can click the square icon in the drawing tool bar. If you would like to erase
all your drawings, click the red X icon.

Sharing and Toggling Drawings

To share your drawings with others, simply upload the project as any other. The
drawings will be contained within the project.

To toggle on your drawings or those that others have made, click on the
squiggle and select the name of the user whose drawings you would like m
to see. Only one user’s drawings can be displayed at any one time.

Drawing Timeline
As you draw, a drawing timeline will automatically be created which displays at

which points on the video the drawings appear. This feature can be turned on and
off (i.e., displayed or not) on the top menu View > Drawings Label.

Note: no description notes can be typed into labeled instances on the drawings
timeline.

EEI Niiactinne I- | B r I_I
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Chapter 10: Conversation Analysis

Conversation Analysis (CA) employs: Jeffersonian Notation (a formalized system of
notation including arrows and other characters), sound waveforms, and a Courier
font, which can be exported as it appears on screen for uniformity of text
positioning. This can be used for linguistic analysis and that of other fields.

CA features can be toggled on or off per user preferences.

Turning On Conversation Analysis Features

Conversation Analysis features can be
turned on or off by clicking: File > Project
Details (or also by clicking the title of the
project in the upper blue bar of the

project).

Once clicked the dialogue below appears.
Near the top, under “Project Type,” you can
select “Regular Project” or “Conversation

Analysis Project.”
Changing Column Width

Turing on CA will allow you to
craft the look of your output (or
printed) transcript as well (for
example, if you need to fit your
text into a single column of a
journal article). In this same
dialogue box, near the bottom,
you can select “Max Text Width,”
to choose how many characters
wide the text of your transcripts
will be.

You can experiment with the
width, as it can be changed at
any time later. 40 characters
may be a good starting point.
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& V-Note lGIJ Online Edit View Timeline

B New Project

0 Open Project
* Recent projects >
B Save Project

B Save Project As...

© Close Project

& Open Video or Audio
& Remove Video or Audio
# Export Movie Builder Video

M Export Raw Data

- Project Details

b - . O Close Application E

©] ® Project Details
Regular Project

LE QT / Conversation Analysis Project $

Title: BBC Forest
Project UUID:  ae53c863587e425b892746691d2f5a51

Owner: brandon Online ID: 35

Description:

Video: 428929ff32d7160eb4/a5e00132373a7031000fd987a3c9f87b ...
v Store Relative Path v Embed video within project file

Max Text Width: 40 characters [T}

Cancel  (NOKIN
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Sound Waveforms: Toggling On and Off

Waveforms (i.e., representations of volume along the sound track) can be toggled on
or off regardless of whether or not CA features are being used. In the image below
the waveform is the black squiggly line between the video/transcript on top and the
timelines on bottom. These can help you to identify activities in the video and
measure periods of silence or talk. On the other hand, you may wish to turn it off in
order to use the space for a larger video window or more timelines.

LK V-Note 1.1.1.SCR1 [Teaching ]
D d 2 0 EY Not logged
< S ke 2s I3 M Start New ... 3 Import Tra... D Copy Tra...
g a B d f_‘ T A B 6s OB ) Fioish Utte.. l ® ExportTr.. |
> 1 = Start Duration Speaker Text
-k 193 00:05:53.560 1s You might mix them up.
= = £
2 194 0 oc. See 98.6 degrees Celsius could be very
ws[ee.es,sa,see 5s different.
196 00:05:59.560 2s It would be almost boiling and uh-
197 00:06:01.500 2s You'd be dead.
198 You know, that's why it is so important
199 00:06:03.560 5s to write that down or to have that
200 written down, if you're writing it down.
00:0 e
Track #1
{(Corwings )]
{[ovestions I
(CPoben )
———

To toggle the waveform on or off, click: —— -
\"/CI'A Timeline Transcript |

v+ Labels

Waveforms
Transcript
'V + Movie Builder |
Drawings Label

View (top menu) > Waveforms.

When the checkmark appear, the waveform
will be displayed.

This function can also be toggled on/off at the
gray bar on the right of the V-Note screen.

Video Change Graph

Similar to the waveform, the video change graph permits you to gain an overview of
the entire video, but with an emphasis on the visual rather than on sound. Toggled
on and off in the same manner as the waveform, the video change graph is shown in
the same place as the waveform, directly below the video play window and the
transcript window. This function can also be toggled on/off at the gray bar on the
right of the V-Note screen.
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Chapter 11: Linking Text Documents to Your Projects
Why Link Text Documents to Your Video Projects?

Generally, the text-link feature of V-NOTE allows a user to drag and drop labeled
instances of video from timelines into a cell of a table or list in order to create an
association between these. These associations (i.e., the text link raw data) may be
explored and analyzed in V-Note or exported to a spreadsheet or other program.
The text-link feature view replaces the transcript view in the upper right of V-Note.

Linking text documents to V-Note video projects can be useful on many levels.
Sports-focused users may wish to link playbooks. Any user may want to categorize,
link a rubric, or score labeled instances from the timeline. Researchers may want to
compare categorization across multiple users in order to calculate interrater
reliability.

o O B 3 D B KB notlogge

A 8 c o E

3 - High Quality 2 - Medium Quality 1- Needs Improvment 0 - Not Observed
1 Score
Organization
2
ial 1]
o o Problems
R1S L]
|l Time Use
4
R19
Interest Level
5
T19
6
Resize $ import * Export
7 1
Redire bl i
I I |erten [ ] 1] I
I |l [
i
i
i
i

= Add Label CTEITS Tl ©' Lead Time - Open: EXJ @ Close: (B © @ Show Segment Duration [ 3 impo.. | & Exp.. hd Time Scale:

Movie Builder

D>

Custom 2

Time Scale: — ==

Turning On Text Links
To turn on text links in V-Note, click on the “View” menu on top. Then, choose, “Text

Links.” This will replace the transcript view. (Itis not possible to view both
simultaneously.) To view the transcripts again, simply select “Transcript.”
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W AccchampionshipGame @ B @ O / W e © B B bandonemig (development) 3%
Text Links (Drag and drop segments to add them to cells) Author: brandonemig

A

1A - This is a first step from a stance position where the player aims directly for his assigned location. For instance, on a

B4

1B - The edge is the area outside the Tight Ends or Tackle (when an End is split) and out to the sideline on each side of the ball.
E1

1C - This is the technique we want our Center to use for the shotgun snaps. Have the Center grab the football on the tip that is

[
2A - The Gap is the area between each Offensive Lineman in any given formation. They are lettered from the Center going out, .

N3 E18 1

2B - This stands for Line of Scrimmage and is the imaginary line that runs from the football to each sideline.

B84
3A - This describes the direction the Quarterback goes once he has received the snap from the Center. If he Opens

-
YL Resize |

$ Import * Export

[ 01 1
| |
[ I0 I

I
|

CTE LTl S Lead Time - Open: EXI] @ Close: [ © @ Show Segment Duration [ 3 impo.. | * Exp.. bd Time Scale:

Movie Builder

Custom 1 Custom 2

W Export Video
Time Scale:

Entering and Importing Text Data

It is possible to add data (e.g., rubric, table, playbook, list, etc) to your text-link
window for linking in three ways. You can double click a cell for direct typing within
V-Note. Alternatively, data in the form of a table or list (i.e., in cells) can be copied
from a spreadsheet program (e.g., Excel®) or table and pasted into V-Note by right
clicking. And finally, by clicking on
“Import” just below the text-link
window, you can import your data
from either a.CSV (comma

separated variable) or .XLSX
(Excel®) file type. ueiitions, responses, redirects/questions

R19

* Export

Altering cell sizes and the number of rows or columns can
also be done. In order to alter row or column size, simply
place your mouse cursor over the lines between the numbers
or letters. The cursor changes to a double-arrow which allows
for the stretching or compressing of a cell. To change the
number of rows and/or columns, click on “Resize.” Once
you've selected the numbers, click “Apply,” and the table will resize. For lists (e.g.,
playbooks), choose 1 column. NOTE: if you import or copy and paste a table into V-
Note, the table will be automatically sized correctly.
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Linking Text to Videos

In order to link your labeled instances to your text-link data, simply drag an instance
from the timeline to the chosen cell. For example, if you judge your second labeled
instance on the “Question” timeline to propose high quality problem to your

students, you
@ V-Note File Online Edit View Timeline Transcript Playback Tools Help

g}:ght drag l_t ttO ‘00 @ V-Note 2.0.0 [Teaching Video - Teaching Video
e appropriate [EYEEET_w= :

column for in ’ : Drag and drop

your text-link 1 A o igh Gualty —
window. Sports | Soor

example: if you b J | Otoenization

found your ' "  Problems [

team’s second |\ B - R15
score was a : i

good example o8 Many soncs. e iggestans - s Hawai. The one at has e Interest Level — =
of Play AQ3, T — g Resize

they it could be e

dragged to the | [interestino Il |
appropriate | [owsin M | || [I" || I [1mportant |
space on the Il [ 1 11l 1l

list.

Exporting Text Link Data

Near the bottom right of the Text-Link window is (15}

the “Export” button. This will allow you to export

the data you have entered (both text and linked . / - £ Eort i
instances). This data can be exported in either .CSV A E:ﬁzﬁ Iz ﬁf;’x

or .XLSX format. The file will render as shown i

below. Data from additional users (if a V-Note [ln

project has been shared with others) will need to be
exported into another file, if needed. This is discussed in the next section.

- A | : I C D
1 | Score 3 - High Quality 2 - Medium Quality 1 - Needs Improvment 0 - Not Obsen
2 O - —14- g (00:01:08-00:01:44) Q 11 -
3 Problems «-- Segments --- R 15 - Student Resp (00:08:15-00:08:25) --- Segments ---T 17 - Teacher Resp (00:10:10-00:10:36)
4 | Time Use - Segments -—- Q 13 - Question (00:07:16-00:07:39) - Segments - | 5 - Interesting (00:07:28-00:12:30) - Segments - R 19 - Student Resp (00:09:48-00:09:56) --- Segments
5 |Interest Level —- Segments -— T 19 - Teacher Resp (00:11:32-00:11:56)
6

= E 55%@) Mon12:42 Q =

. , .
Multiple Users’ Text-Link Data @ B B brandonemig deveiopmenty JE3

Author: brandonemig

Similarly to other V-Note features (e.g., Author: brandonemig
drawings, timelines data, transcripts, etc), the t 0-NotObse Author: brandon (read only)

, . . . Author: d onl
data from other users’ text-links is available. ARG G

The text-link display can be toggled between
users by clicking on “Author” in the black bar
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in the upper right of the text-link window. When clicked, a list of all users with
whom the project is shared will appear. When the user’'s name is clicked, his or
her text-link data will appear and can be viewed and exported.

Interrater Reliability

The V-Note Team is currently working on an in-app automatic solution for
interrater reliability, which will calculate Cohen’s kappa and percent agreement.
Currently, however, the easiest solution for calculating this is to invite all users’
with whom a project is shared to categorize instances (possibly marked with
notes within the labeled instances) by dragging them into a text-link
corresponding to one category (e.g., a given column or cell) among possible
choices on their own.

Additional users are able to copy the table data from the owner by right clicking
anywhere over the text-link window. Exporting these data files from all users can
allow for comparison and calculation of interrater reliability.

Note: it is also possible to compare various users’ timelines directly to calculate
agreement, however, given the likelihood of labeled instances overlapping to
varying degrees — from slightly to completely — this could make for ambiguous
results. This type of agreement might make for a constrained, initial qualitative-
type round of analysis, for those wishing to take a more quantitative tack
eventually.
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Chapter 12: Using Multiple Videos

Managing Multiple Videos in V-Note

V-Note Full Version supports the use of multiple videos played together in the same
project either in series (i.e., one after the other) or in parallel (i.e,, all playing on the
screen at the same time). In the latter case, the videos can even be automatically
synchronized by their soundtracks (provided they are recorded of the same event at

approximately the same time.) This can
save many hours of time otherwise spent
manual synchronizing.

If you have the full version of V-Note,
simply click on > “File” (on top menu) >
“Edit Playback Sources” to access the ability
to manage how your videos are played.

Once clicked, you will see the dialog below.

I V-Note m Online Edit View Timelin
I ©

B New Project
1 Open Project
+ Recent projects >
B Save Project

B Save Project As...

© Close Project

Multiple Vid

Edit Playback Sources
& Clear Playback Sources

In the upper right, there is a list available for clicking including: “Parallel Mode,”

“Serial Mode,” and “Add Video Later Mode.”

@] Playback Sources
Playback mode: +/ Parallel Mode
Files: Serial ‘Mode
Add Video Later Mode
Add Remove Sync Videos
Output Layout
Rows: 1 Columns:
¢ Free Output Aspect Ratio (drawing will be disabled)
Common Aspect Ratio: 3:2
Custom Aspect Ratio: 1 : 1
[ Ok}

Clear All

Cancel

The “Add” button, when

- clicked, allows you to browse
your video (or audio) files,
which will be played in: parallel
or series, per your choice.

“Add Video Later Mode”
presents a black screen and a
ticking clock, and can be used
for live coding when a video is
recording via one or more
external cameras. Labeled
instances can be made on
timelines according to real live
events. Then, adding the
video(s) can be done later
according to usual instructions.
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Parallel Mode

Once videos have been added via the
browser and the parallel mode has
been added, the orientation of the
screen can be selected. Both images
below show the same three videos
added, but the top image shows 1 row
and three columns, whereas the
bottom image shows 2 columns and
two rows. Playing in series mode
allows only one video to be played at a
time with second and third videos, etc,
being played only after the first one
finishes. Itis not currently possible to
mix and match, i.e., to have both series
and parallel videos in one project.

Playback mode:

[C] Playback Sources

Parallel Mode |V

Files:

Caillou FRANGAIS - PLUS QU'UNE HEURE COMPLETE DE CAILLOU.mp4 [ o
US4 Rocks.mp4 [ offset: 0 secs ]
US3 Sunspots Pulleys.mp4 [ offset: 0 secs ]

Add Remove Sync Videos Clear All

Output Layout

Rows: 1 C  Columns:

© Free Output Aspect Ratio (drawing will be disabled)
Common Aspect Ratio: ~ 3:2

Custom Aspect Ratio:

BRI cancel

00:00:35.338 / 01:04:11.865

Drag to resize and reorient the
screen and videos
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V-Note does not arbitrarily limit the number of videos that can be played in parallel.
At the time of testing, a computer with a 2.8 GHz quadcore processor is capable of
simultaneously playing before stuttering:

« 5 highly compressed videos (approx. 180 Mbs / hour)
¢ 1 non-compressed 4K video (approx. 350 Gbs / hour)

Your computer will vary depending on many factors. If playback sound or image
should stutter, please remove one video or compress them into a smaller format
using another program for smoother operation. You an also experiment with
playback settings to improve playback under Preferences/Settings > Playback
Settings accessed per instructions in Chapter 1.

Aspect Ratio

Please note that at the bottom of the dialog on the preceding page there is an option
to adjust the aspect ratio. This is independent of the columns and rows, and can be
thought of as a sort of canvas onto which the other videos are laid. This is to
accommodate any drawings you may add to your projects. Drawings are overlaid
onto the video(s); they are not rendered together into one file. You may set this
ratio as needed to suit your own preference aesthetically before making any
drawings. It is not, however, advisable to alter this aspect ratio once drawings have
been made, as this would alter the drawings’ relationship to the videos onto which
they are superimposed.

Serial Mode

Serial mode could be used in cases where it is ideal that labels/hotkeys be reused in
exactly the same way over multiple events occurring over time (a season’s games, a
student teacher’s lessons, etc.). This not only eliminates redundant work (e.g.,
creating new project, adding same labels over again, etc.), but it can also allow for
easier creation of a player’s score video history, for example. Similarly, a numerical
data file that is output would have data from all the videos.
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Live Coding with Add-Video-Later Mode

As mentioned, live coding can be done
(say, of a sporting event, or a
demonstration lesson) by using “Add
Video Later Mode.” Make codes and 00:0018.033
apply them with hotkeys as usually, but
rather than watching a video, you are
watching the live event, to which you
will add the video later. The video can
later be shifted left or right vis-a-vis the
timelines to align things if your labeling
and video recorder(s) should start at different times.

Shifting Timelines with Respect to Videos

If your video recording and timeline labeling did not start at the same exact time, it
is possible to shift the timeline left or right to correspond with the video. To do this,
click > Timeline (top menu), then > Edit Timeline Offset. A dialog (shown in the
image below) will appear. This will allow you to shift the timeline left and right to
the millisecond in order to make it align with your video.

& V-Note File Online Edit View Transcript Playback Tools Help
V-Note 2.0.0 [test]

Speaker  Text

€] Timeline Offset Editor

Timeline offset: 3.000 seconds _
able.
cancel (T
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Synchronizing Videos

If you click on “Sync Videos” in the Playback Sources dialog, you will be presented
with two options: “Manual Sync” and “Auto Sync.” If your videos were recorded at
the same event and recorded generally the same sounds but from different
locations, you should try to auto-sync the videos. Simply click on “Auto Sync” at the
top so that it is highlighted in blue, and then click on OK. The process will take
several minutes or more depending on how many videos there are and the bitrate of
each. Confirm that the tracks play together by adjusting the volume of each track to
the middle

e o Video Sync Prototype [Compiled on Aug 12 2016 18:42:03)

from the V- an sy [EITETES
N ote M all‘l Base Video For Auto Sync:  US3 Sunspots Pulleys.mpd B dosmean

Screen so that e coduis s oo
both are o ¢ Dl
audible. If they
are not well-
synced, you
should try to
manually
synchronize ;
the tracks. au '

If your videos do not record the same sounds, but you still want them synchronized
e.g., an announcer track, a narration track, same event but very different record
locations, etc.), choose manual sync. This will present a window in which the videos
and their respective
waveforms are visible.
A right click will allow
you to make red
markers labeled A, B,
etc. By playing the
tracks, you should find
an aligning event early
in the files (e.g., a
score, a noise, a
transition, etc.). Then, ' i—
drag the markers on

each track to the same event. Next, repeat by adding another marker, B, and then
finding a later event to align. Once the marker B is placed on an aligning event on
both tracks, right click and select, “Fine Tune Markers.” The dialog below appears.
While listening to a loop (short few second part over and over) of audio immediately
around both markers, you can shift them with the shift arrows. Once you are
satisfied with your alignment, you can choose, “Apply” which will align the tracks
together in your V-Note project for all future playbacks. No further efforts should
need to be made to synchronize the tracks.

on Aug 12 2016 18:42:0:
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Frame: 00:01:08.541 (00:01:08.5641)  Video 2

@ Fine Tune : Marker B

Loop duration: 50s °
Volume #1: 100 °
Volume #2: 100 °
-5.400s © >

Auto Refine
Correlation:  10%

BT concel

Auto Sync Align 1-1

Cancel Save

If your videos are not continuous (e.g., one video has pauses or gaps different from
the other(s)), they will not synchronize. V-Note looks for correlation of the
waveform shapes of each video’s sound track and can stretch or compress to
achieve synchronization.

Sharing Multiple-Video Projects with V-Note (Non-Pro) Users

V-Note, our free version, does not support some features that our V-Note Pro
version supports.

The playback of projects with multiple videos is supported on V-Note Pro but not on
our free version. Nonetheless, projects made with multiple videos are somewhat
compatible with V-Note (non-Pro). Only the first video (top of the list) will play in V-
Note (non-Pro), however. If shared with V-Note (non-Pro) users, your projects with
multiple videos should be arranged so that the most important one (best angle, etc.)
is listed as the first one, as this is the one they will see.

There are a few more features that are not available on V-Note (non-Pro) for shared

products. These include: Inter-rater reliability (IRR), transcript exporting to Excel®
or other programs.
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Chapter 13: Millisecond Mode

Labeling by the Millisecond

Called “Millisecond Mode,” this mode allows one to label instances with a minimum
duration of one millisecond. It can be enabled by clicking > “Timeline” (on the top
menu) > “Milliseconds Mode.” Millisecond mode is only available on V-Note Full
Edition. V-Note (non-Pro) users will see instances labeled correctly on shared

projects, but cannot make them to the millisecond. PORREM Transcript  Playpeck 1o
L . View Mode > 2
Once enabled, the minimum duration for a labeled Clear Timeline
instance is 0.001 seconds, or 1 millisecond. Import Labels/Timeline
Without this mode enabled, the minimum Export Timeline
. . . Export VCG
duration is 1 second for a labeled instance. Exzon o
Obviously, any increment above 0.001 seconds is Export Tags
also available (e.g.,, 0.5, 0.01 s, etc.). Export Labels And Tags

Add Label
This can be useful when video is played back in

slow motion, when it may be possible to label
several instances of something in one second or
less, or when labeling a race or other type of .
competition when milliseconds separate a winner from second place Single Press
Mode and Double Press Mode both work as before with Millisecond Mode.

Edit Timeline Offset
Edit Tags

Milliseconds Mode

Outputting Data by the Millisecond

When outputting data, smaller units of export than 1 second may also be chosen.
Each line in the numerical output file would correspond to 0.001 second, for
example, of that unit were chosen. Also, when “Edit Interval” is clicked in the
“Export Raw Data” dialog, a custom interval (e.g., 0.07 seconds, 0.53 seconds, etc.)
can be set and saved. This can be useful in harmonizing your data to your labeled
instances (e.g., you have set a single press label to 0.53 seconds to correspond to a
phenomena of a given fixed length that you are evaluating).
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Chapter 14: Inter-Rater Reliability
Setting Up Inter-rater Reliability

V-Note Pro supports automatic inter-rater reliability (IRR) calculations. IRR is not
calculated from timeline and label overlap between users, as ambiguous cases
would no doubt be present from partially overlapping instances. Inter-rater
reliability calculations require some constraints per convention. Particularly, an
instance must be shared exactly between raters (i.e., same start and end time) and
be assigned to one of a fixed number of categories (also shared between users). To
these ends, V-Note provides an IRR-specific interface.

Interrater Reliability

No Interrater Reliability Table Defined

It can be accessed by clicking, on the top-menu: > View > Inter-Rater Reliability. Or
use the button highlighted in blue to the left.

Please note: ONLY the owner of a project can set up IRR on their project; other
users may not.

If you are the owner of the project and would like to set up an IRR table, click the
large gray round button show above.
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The upper right field will now change to the IRR field with columns, as shown
below:

© B Bbrandn 3k

Untitled, 10 * Author: brandon [0/01,

Happy 0 . Neumtic | o

Drag'n'drop labeled instances from timeline here if you want to add them to Interrater Reliability
Table

These columns are untitled by default. You can click on the “Untitled Column #X”
titles to type to change them to your categories as shown below.

You can also add change the title of the IRR table and number of columns by
clicking the “Untitled” part in the upper left of the IRR field as shown below.

Untitled, ©

Edit Title

Add Column

Delete Table

Drag'n'drop labeled instances from timeli

Once your IRR table has all the categories it will need, you can begin dragging up
the labeled instances (yours or others’) to the columns (i.e., categories) per your
judgment. The instances will be represented in their respective IRR columns where
they can be removed or placed into another column from dragging and dropping.

As an owner of the project, you will NOT require the “Unrated” column, although if
you would like to mark an instance to be rated by other users (or yourself later;

70 V-Note User Manual



maybe you are unsure how to rate it, for example), you can use this column. It will
not be considered in calculations of IRR, however.

Users with whom you share your project will see, on their view, all the
instances you have rated in the “Unrated” column, in order that they
can see any remaining instances that need to be rated/categorized but
they will NOT see your original category choice. This is by design so

that ratings are truly independent. In those cases where resolving
differences or otherwise collaborating is desired, you can do so via our
“General Notes” or “Private Notes” functions at shown by these icons.

All instances that an owner has dragged into a category are highlighted with respect
to un-rated instances, so that they might be more easily identified and viewed in
their original context. The image below shows these labeled instances on their
timelines as darker than those which are not rated in IRR.

VMmnstesTest @ B @ O a8 / B “ © B B bendon

IRRTEST, © 2% Author: brandon [9/9],
1

Nervous Happy 4  Ecstatic 4 Unrated 0
LS
L14

e
I
T
It's adjustable
00:00:44.164 | 00:03:48.996 “ |10

% Add Label Double Press Mode  [lFSERIREIPURY2 05 | JCER0.05 |- [ EISRIVHERIN & import Labels/Timeline | & Export Labels/Time... LSRN0

Movie Builder

W Export Video Little Guy Test from Win10 Custom 1 Custom 2
Time Scale: el

Again, all these instances will appear in other users’ IRR field under the “Unrated”
column. The specific categories the project’s owner chose will NOT be visible to
them in order that they can rate them independently. Collaboration with other users
should take in-person or via place via “General Notes” or “Private Notes”
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Using Inter-rater Reliability in Projects Shared with You

If you would like to participate in rating .‘ A NN AN st a ;::enne Tarsci i
a project shared with you by another - Waveforms

user, you must first join and open the v - T
project if you have not yet done so. L

Details on how to do this are provided i

in chapter 3 beginning on page 14 of

this manual.

v+ Movie Builder 21
« Drawings Label
* Labeling Buttons Side-Bar

B Multi-Project Workshop

© Pending Uploads 51
. . 7 Drawing Tools 61
Once you have opened the project, click —— il

on the top menu: View > Interrater
Reliability. This will change your upper
right field to that with IRR information.
If the project’s owner has not yet added any instances to be rated, you will see a
statement: “No Inter-rater Reliability Table Defined.” As a non-owner, you will not
be able to create any categories. You will need to contact them to ask them to rate
some instances and push these changes to V-Note’s server.

Exit Full Screen
00:00:44.164 |/ 00:03:45.59

Interrater Reliability

No Interrater Reliability Table Defined

If a project-owner has rated some instances, you will see all of them appear in your
“Unrated” column at right, as shown below. You will not see into which particular
categories s/he has placed them; this is by design so that rating is independent.

You can right click over these instances in the IRR field to locate them on the
timeline or to begin playing them. When you think you know the category (e.g.,
happy, sad, nervous, etc) drag the instance in to the respective column, where it will
appear. It will then disappear from the “Unrated” column. You can change these
later.
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V-Note Pro 2.1.1 [Online Project: Monsters Test]

© B Bbrandn 3

IRR TEST_ ©® 1+ Author: brandon [0/8],

Nervous 0  Ecstatic 0 Unrated

Once you have rated (i.e., categorized) all instances, your “Unrated” column will be
empty. Please push changes to server using the button on the upper left on the blue
bar, or on the “Online” top menu choose “Save Changes to Online Project.” This will
include them in the calculations the owner of the project will make using V-Note.

Please note, as a user (non-owner of the project), you are NOT able to select
instances for IRR categorization that have not been selected by the project owner. If
you would like to suggest a new instance for IRR consideration, please contact him
or her directly noting the instance to him or her, and possibly adding a note within
the instance on the timeline to this effect, (assuming it is yours and notes can be
made in it).

Exporting IRR Data

Once all users have rated the

instances (or even before), you as

an owner can export the data by

clicking on the upward B
export arrow in the IRR H

I field near the top in the

brandon (10710) black bar. You will now be able to

awis [0/0)

bcoamp (8001 | select the users whose data (IRR
(001 choices) you would like to include
e o in your calculations as shown in the

image below.

Interrater Reliability Table Export

Users:
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You can now select the export format you would like to use by clicking on the drop-
down menu called “Export Format.” The choices are shown in the image on the next

page.

Nervous

Raw Data
Fleiss Kappa
Cohen's Kappa (Unweighted)

SOLIR{InEE  Cohen's Kappa (Weighted - Linear) <

Cohen's Kappa (Weighted - Quad)
Intraclass Correlation

| L4 wiranuurnienny 1ojojg
brandonemig?2 [8/8]
jeff [0/0]

mirkolive [0/0]
whiteej [0/0]

Users:

ASEASEANEAN

V-Note's Inter-rater Reliability Features are in Beta.
Please verify related calculations.

inste] =L Export |

You can choose: Raw Data (IRR), Fleiss Kappa, Cohen’s Kappa (unweighted),
Cohen’s Kappa (Weighted Linear), Cohen’s Kappa (Weighted Quadratic), and
Intraclass Correlation. Raw data (IRR) will only display who categorized what
where and allow you to perform other calculations elsewhere.

These differ in important respects such as tendency toward linearity, number or
raters accommodated, and logarithmic-type data. Please research elsewhere which
is best used in your case. That said, an outline is provided in the next paragraphs.

If you are using many raters (more than two), you may find it is best to use “Fleiss
Kappa,” as Cohen’s Kappa can only compare two raters at one time. Note that it is
still possible to use Cohen’s Kappa with more than 2 raters with V-Note, but data
will be output which compares raters 1 & 2, raters 1 & 3, and raters 2 & 3, and so on,
each on it’s own Excel® sheet. Fleiss Kappa data will include all users and render
data on only one page.

“Unweighted” means there would be no expectation of central tendency (e.g., Likert-
type data has central tendency). An example of unweighted data would be the
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categories: neurotic, sad, happy, etc. There would not necessarily be a linear scale
associated with these (i.e., one is greater in degree than another). “Weighted” data
could be exemplified by categories such as: strongly agree, agree, neutral, disagree,
strongly disagree, and the like.

All files are exported in XLXS (Microsoft® Excel®) format and can be opened
directly by that application. When opened, the files will render as shown below.

| A \ B \ C \ D | E [ F |
1 |Labeled Instance Nervous Happy Ecstatic Unrated P
2 |B2[Big Guy ] 00:00:05-00:00:10 0 2 1 0 0.333333
3 |L3 [ Little Guy ] 00:00:29-00:00:34 0 2 1 0 0.333333
4 |Q4[Question ] 00:00:29-00:00:34 0 1 2 0 0.333333
5 |B6 [ Big Guy ] 00:00:32-00:00:36 0 3 0 0 1
6 |B 8 [ Big Guy ] 00:00:34-00:00:57 2 1 0 0 0.333333
7 |LA4[ Little Guy ] 00:00:36-00:00:39 1 1 1 0 0
8 |L5][ Little Guy ] 00:00:37-00:00:43 0 1 2 0 0.333333
9 |L 15[ Little Guy ] 00:02:25-00:02:3 0 3 0 0 1
10 |P 0.125 0.583333333 0.291666667 0
11
12 |Fleiss Kappa: 0.031055901 Slight Agreement
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Chapter 15: Statistics for Comparing Timelines

Introduction to Statistics for Comparing Timelines

There may be times when you want to compare labeled instances between
different timelines for overlap. In so doing, you can compare between different
peoples’ labeled instances or labeled instances between one or more of your own
timelines. This can provide compelling data such as agreement or similarity
between definitions (i.e., labels’ meanings) or between the uniformity (or lack
thereof) in how labeled instances (codes) are applied and understood between
individuals.

Unlike Inter-Reliability (IRR) calculations - discussed in Chapter 14 - which are built
around common standards for reporting agreement statistical agreement, this type
of statistic differs in two important ways. On the fortunate side, good agreement
that occurs between users - particularly if users are blind to what others have coded
(a “blind” setting is available when you share) - is more compelling, as instances
are generated in a relative vacuum, as it were, by multiple users from the within the
whole of the video. Good overlap of this type is not to be generally expected.
IRR, on the other hand, employs discrete instances with beginning and end times
established in advance. On the unfortunate side of things, however, you will need to
describe fully and unpack what this means and how it was calculated to readers of
your research or data who may not otherwise be familiar with V-Note and this type
of overlap.

Analyzing Overlap Between Users

Comparing how different users apply labels to instances (i.e., code video) can be
useful in forming a shared sense of a definition, a shared sense of practice or
technique, or in proposing novel models for human behavior. V-Note has thousands
of users around the world who are primarily interested in this use, including:
surgeons, consumer researchers, educators, teacher trainers, researchers in all
fields of the humanities, psychologies, sports coaches, and more. V-Note can be an
important driver of convergent thinking (i.e., getting everyone on the same page) in
these use cases.

There are two

Waysto [(oosdiowmins |l + J:lD ﬁh e ——— - é}

compare with P o

respect to the M
user. The first ﬁ il "”ﬂljm A
is by displaying

a histogram by clicking at the bottom left of the timelines field (shown encircled
above). The histogram is represented by the gray bars below the timelines in the
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screenshot. You can also export this to a spreadsheet by clicking on the right icon
for exporting (bottom left of timelines field) and choosing “Histogram.”

Scan QR Code for a Tutorial on Comparing E 1
Peoples’ Codes [

File Online Edit View Timeling .I

New Project

Open Project
Recent Projects The second way to compare users’ timelines is by

Save Project exporting descriptive overlap statistics to a spreadsheet
S program such as Microsoft® Excel®. This can be done by
as shown in the screenshot at right. To compare labeled
instances between users, choose “Per Label.” This way,
each worksheet within the Excel® (or any spreadsheet
program) project will bear the name of a label. When a
Bop Dt single worksheet is opened, you will
Overlap Statistics Time - Between Labels see data as shown below. The top of
Nested Statistics Time - Between Users the screenshot shows an exported
g N eee Pl spreadsheet and the bottom shows
Project Details Number - Between Users timelines within V-Note.

Close Project

Export Movie Builder Video

Export Histogram

Close Application
We see that two individuals have labeled instances on
timelines for “Interesting and Good Learning.” These are the tabs for worksheets.

File Home Insert Draw  Page Layout Formulas Data Review View Help O Tell me what you want to do 7 Share
F9 - f v
A B (e D E F G H | ] K L M -
1 Statistics Mode: Time (Per Label)
2 Project Title: Classroom Analysis
3 Date: Thursday, October 25, 2018 9:06:30
4
5 brandon john
6 00:02:56.069 00:00:34.634
7/ 2 segments 1 segment
8 brandon
9  00:02:56.069 100.00% 16.27%)
10 2 segments
11 john
12 00:00:34.6 82.72%) 100.00%
13 1 segment’
= e ’
Interesting 008 Learning  Explanation ‘ »
! £ v-Note Pro 2.5.3 [Online Project: Classroom Analysis|

File Online Edit View Timeline Transcript Playback Tooks Help
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Consider just the “Good Learning” timelines. We can see that Brandon’s labeled
instances are below those of John. We also see that there is good overlap between
John’s single labeled instance and the second labeled instance of Brandon.

[EL

= IR
EE=a IR

&

Looking at the spreadsheet data below, we can see that 82.72% of John’s labeled
instance (aka coded instance) is overlapped by a labeled instance(s) of Brandon’s.
On the other hand, looking at Brandon'’s labeled instances, we can see that John’s
labeled instance overlaps with only

. A B c
0 )

16.27 /o. of Brandon'’s 1nsta}nces. Note 1 [Statistics Mode:|Time (Per Label)
that all instances are considered 2 Project Title: Classroom Analysis
together as a Summed total 3 Date: Thursday, October 25,2018 12:45:28

4

. . o L 5 brandonemig john
While this descriptive statistic is useful | 00:02:56.069 00:00:34.634
for conveying how liberal or 7 2 segments 1 segment
nservati n rson li 8 | brandonemig
C(_) Servative one pe SO app esa 9 00:02:56.069 100.00% 16.27%
given label when compared to another |10 2 segments
person, we must bear in mind that it 1 john
: 12 | 00:00:34.634 82.72% 100.00%

can be necessary to convey both sides

13 1 segment
of the overlap: John:Brandon and 14

Brandon:John, as described in the preceding paragraph.

Note that total times of the labeled instances and the number of total labeled
instances are also shown in the table above and may be marshalled into comparison
evidence per your needs.

Regardless of your goals for this type of statistic, you will need to explain it to your
audience. Unlike Inter-Rater Reliability (a.k.a. IRR, discussed previously which is a
standard set of statistics that are calculated and shared commonly, overlap
described in this way does not have a long history of being shared and will need to
be well unpacked for your audience - possibly with graphics similar to ours. If good
agreement between labeled instances occurs without prior agreement (if a coder
had the project shared “blind” to any prior codes of others) is very compelling and
indicates uniform application of a label (code). In fact, high agreement of this type -
i.e, generated in a vacuum - is more compelling than traditional IRR data and is
worth the extra effort to explain. That said, we can expect it to be relatively rare.
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Analyzing Overlap Between Labeled Instances

You may desire to compare timelines and their
respective labeled instances between labels (i.e.,
codes) rather than people. This can be useful in
determining If the “Per User” selection is made,
your spreadsheet pages (i.e., worksheets) will have
tabs with the titles of the users. When you click a
user’s tab for a given worksheet, you will be able to
compare your (or another users’) codes to one
another. This will allow you to look for conceptual
overlap or keep score in a sporting event.

!.I.:'

Instances Between Timelines

&Y V-Note Pro 2.5.2 [Untitled]

File Online Edit View Timeline Transcript Playback Tools Hely
B New Project

3 Open Project

* Recent Projects »
B Save Project

B Save Project As...

© Close Project

B Edit Playback Sources
= )

W

£ Export Histogram

@ Export Raw Data

£ Nested Statistics > £ Time (Per Label)
@ Project Details £ Number (Per User)

© Close Application

Scan QR Code for a Tutorial on Comparing Overlap of Labeled

Comparing Overlap by Number of Labeled Instances

The timelines in the screenshot below represent labeled instances made of a
baseball game. In this case, all the hits are labeled on the first line. Players’ names
are listed on the bottom part of the screen, beginning with “Smith.” By pressing two
keys - corresponding to labels - at the same time, two labeled instances are laid
down at the same time. A quick visual scan of the timelines shows who made a hit

when.

Labeled Instances on Timelines for a Baseball Game
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The same data in the baseball screenshot above is rendered into a spreadsheet
shown below by choosing: > File > Overlap Statistics > Number (Per User). This
means that the user is held constant and we compare labeled instances between
timelines (i.e., labels) for a given single user. In this caser we compare only the
number of labeled instances; we do not care about the duration of each codes or the
total of all codes in this type of data rendering.

Note that as we go across the top row of data, called “Hits” (below the labels), we
see the percentage of hits made by each player. Jones has 15.38%; Miller has
23.08%, etc. As we go down the hit column (column 1), on the other hand we see,
the percent of the time that were hits from among all the times that the player was
coded (others could be catches, for example). We can also see that 15.38% of all hits
resulted in a run.

@ Excel File Edit View Insert Format Tools Data Window $ Help @SN &« T o 73%%) B Wed2014 Q @ =
- ——
@ ® ™ baseball data.xIsx [Repaired)

CEHOEM x ' » 90 W #hex ™ © Q-
A Home Layout Tables Charts SmartArt Formulas Data Review ~ S
Em Fom Asgrment Number Format Ceis Themes
I- . ® Fm v Calibr v12 v/ A~ A~ [ sbcr [ IWnpText v Genera . r £ Norma -, Bo. m e Aa>, S8°
35 S =2
paste S Cewr~ B I U 2 dpAL (ELE S sty G- % > % Emmm:\: - insert  Delete Formst  Themes Ad~
L] C o £ F (4 H 1 ) K L

3 Date: September 6, 2017 8:07:52 PM EDT
a
s Mt Run Strike Out Error Senith Jones Miller Jenkiny Ebman Salamy Herschel
6 00:03:02 000 00-00:28 000 00:01:10.000 00:00:14.000 00-00:56.000 00:00:56 000 0000 42 000 0000 28 000 000000 000 000028 000 00-00-28.000
7 13 segments 25 1 5 segments 1 segment 4 segments 4 segmen 3 segments— 2 segments 0 segments 2 segments 2 segments
8 H
9 000302000 100.00% <&s; 0.00% 0.00% 15.38% 6’8\ ( ;“9 15.38% 0.00% 15.38% 769%
10 _13 segments
1 Aun | | | | | | | | | |
12 00:00-28.000 100.00% 100.00% 0.00% 0.00% 0.00% 0.00% 50.00% 50.00% 0.00% 0.00% 0.00%
13 I:.mer-n
18] Strike Out | | | | | | | | | |
15 0001:10.000 0.00% 0.00% 100.00% 20.00% 40.00% 40.00% 0.00% 0.00% 0.00% 0.00% 20.00%
16 S segments
17|  Emor | | | | | | I | | I
18 00:00:14.000 0.00% 0.00% 100.00% 100.00% 100.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%
19 1 segment
20 Smith | | I I | I I I I I
21 000056000 $0.00% 0.00% S0.00% 25.00% 100.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%
22 l\smeﬂn
23| Jones | | | | | | | | | |
24  00:0056.000 50.00% 0.00% 50 00% 0.00% 0.00% 100 00% 0.00% 0.00% 0.00% 0.00% 0.00%
25 __ 4 segments
261  Meller | | | | | | | | | |
27 000042000 100.00% 33.33% 0.00% 0.00% 0.00% 0.00% 100.00% 0.00% 0.00% 0.00% 0.00%
28 3 segments
29| Jenkins | | | | | | | | |
30 00:00:28.000 100.00% $0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 100.00% 0.00% 0.00% 0.00%
i 2 segments
32|  Ebman | | | | | | | | | |
33 000000000 0 00% 0 00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0 00% 0.00% 0.00%
34 O segments
35 7 Salamy A | 1 I I I I 1 1 I 1
36 0000 28.000 10500% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0 00% 0.00% 100.00% 0.00%
37 )\ﬂnn
38| Herschel | | | | | | | | | |
39 00:00-28.000 50.00% 0.00% 50.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 100.00%
40 _2 segments
41
< =+ 0 unnamed user / xplanation | + I b |

Tables such as this will produce extraneous data in addition to what you are

seeking, so it is important to know how to interpret the data within them and verify
that you have the correct data.

A simpler example of the same type of data rendering may be helpful. It is shown on
the screenshot on the next page. Note that Brandon has 2 labeled instances for
“good learning” and one for “interesting.” One of these “Good Learning” partially
overlaps with the “Interesting” labeled instance; thus we see 50%. All “Interesting”
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labeled instances (in effect, one of them, in this case) are overlapped, thus we see
100%. We also see 100% showing that each code overlaps 100% with itself.

File Home Insert Draw Page Layout Formulas Data  Review View Help 0 Tell me what you want to do &3 Share

F11 v fe
A B (= D E F G H | J K L M N -
Statistics Mode: Number (Per User)

Project Title: Classroom Analysis
Date: Wednesday, October 24, 2018 13:52:05

00:07:26.824 00:02:56.069

1

2

3

4

5 Interesting Good Learning
6

7 1segment 2 segments
8

Interesting
9  00:07:26.824 100.00% 100.00%)
10 1segment
11 Good Learning
12 00:02:56.069 50.00%, 100.00%

13 2 segments
14

brandon | john = Explanation + «
Ready B [ P - 1] + 100%

D V-Note Pro 2.5.3 [Online Project: Classroom Analysis)
File Online Edit View Timeline Transcript Playback Tools Help

Brandon

Comparing Overlap by Time of Labeled Instances

The prior example considers overlap but does not consider the duration of overlap.
Any overlap whatsoever is counted as overlap in a binary way, i.e., 1 or 0. By
choosing > File > Overlap Statistics > Time (Per User) we will consider only duration
of the overlap between labeled instances on different timelines.

File Home Insert Draw Page Layout Formulas Data Review View Help 0 Tell me what you want to do 2 Share

E10 v fe v
A B C D E F G H 1 J K L M -

1  Statistics Mode: Time (Per User)

2 Project Title: Classroom Analysis

3 Date: Wednesday, October 24, 2018 13:51:52

4

5 Interesting Good Learning

6 00:07:26.824 00:02:56.069

7 1 segment 2 segments

8 Interesting

9 00:07:26.824 100.00%) 32.69%)

10 1 segment

11 Good Learning

12 00:02:56.069 82.96% 100.00%)

13 2 segments

14 hd
_brandon  john | Explanation ® “« »

Ready Gl = 1 + 100%

V-Note Pro 2.5.3 [Online Project: Classroom Analysis)

File Online Edit View Timeline Transcript Playback Tools Help

Brandon
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A simple example is shown at the bottom of the previous page using the same data
just discussed. The top half of the screenshot represents spreadsheet data of the
timelines in the bottom half, as before. The difference is that we see the overlap
percentage in terms of duration. Gone is the binary: yes/no for overlap. Thus, we
see that of all of the labeled instance time laid down (over multiple instances) for
“good learning,” 82.96% of it is overlapped by another code, in this case
“interesting.” 32.69% of the “interesting” labeled instance time is overlapped by
“good learning.”

Here, too, it is important to ignore self-overlapping labeled instances (always 100%)

».n

and keep the orientation of one’s data straight: “interesting”:"good learning” versus

».n

“good learning”:”interesting.”

You may find it helpful or necessary for your argument to include and explain
various types of data from among those discussed here: overlap time percentage,
overlap number percentage, total number of labeled instances, total time duration of
labeled instances, etc. Also, Inter-rater reliability (IRR) type data - (See Chapter 14)
may be a simpler approach for your needs.
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Analyzing Your Nested Codes

Making and applying nested labels
or nested codes is discussed in
Chapter 2 (p. 14). Generally, when
labels may have a hierarchical
relationship with one another,
nested codes are used. You may
consider them to be sub-labels or
sub-codes. For example, at right a

& V-Note Pro m Online Edit View Timeline Transcript Playback Tools Help

& B New Project %N V-Note Pro 2.4.2.nl [baseball sample nested - baseball saj
© Open Project i
* Recent Projects »

B Save Project ®S
B Save Project As...
© Close Project

& Edit Playback Sources
& Clear Playback Sources
=5 W Export Movie Builder Video

£ Export Histogram
@ Export Raw Data
£ Overlap Statistics

Nested Statistics

@ Project Details
© Close Application

00:01:20.5676 / 00:11:12.868

baseball player is shown with
various labels that apply only to
him: up to bat, hit, foul, run, etc.
These can be applied to other
players in the same hierarchical
manner also.

The use of nested codes provides a quick visual of the relationships between codes.
Also, employing nested codes in V-Note allows us to use a special function of V-Note
for determining descriptive statistical relationships between the codes.

Accessing these statistics is done as shown in the picture above. Choose “File” from
the top menu. Next, choose “Nested Statistics.” You can then choose between
“Number” and “Time.” Once selected, provide a name for your file. This will open in
your favorite spreadsheet program, such as Microsoft® Excel®.

Number-type calculations are done with respect only number of labeled instances
(e.g., 10% of pitches were hits); the amount of time of each instance or all together is
not considered. Time-type calculations, on the other hand, are done only with
respect to time of codes (e.g., Jones spent 5% of time up to bat); the number of
individual labeled instances is not considered.

The screenshot on the next page shows an example of the Number-Type
calculations. It shows that Jones was labeled (i.e., coded) three times and two of
those times (i.e., 66.67%) of those times he was up to bat. (The other time he may
have made a catch.) The exact labeled instances are circled in red. The calculation of
the % is shown circled and linked, also in red.

Note also that each level or labels is linked to all higher levels of
codes. For example, “hits” is liked not only to “up to bat” but also to
“Jones.” The relative frequency will be calculated with respect to
the level labeled on top of the Excel ® document.

Scan QR Code for Tutorial Video on Nested Labels & Statistics
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Nested Codes Statistics Calculated by Number
(Excel® on Top; V-Note on Bottom)

@ V-NotePro File Online Edit View Timeline Transcript Playback Tools Help ® B

LA N ] D8 wov-J +

Insert Page Layout Formulas Data Review Vie

Y .
v alib * 12 A B | 0 Wrap Text - A .
. == Delet .- - Y
Paste BiXiWi . v ] B Merge & Certer * $ %% ||% Sort&
~ orma V" Fiver
Al - fx levell v
A ] C o € ¥ [9 L 1 ) x L ~M N L
Level 1 Level 2 Rel Freq. to Level 1 Level 3 Rel Freg. to Level 1 Rel Freq to Level 2 Level 4 Rel Freg to Level 1 Rel Freq to Level 2 Rel Freq. to Level 3
Jores  UptoBat FETET 200.00% Foul FTETN 50.00% 25.00%
Run 66E7% 100.00% s0.00%
66T 100.00%
Catch IR LY
Error 000%

Nested code statistics calculated by Time are similarly created (except you click on
“Time” instead of “Number” from the “File” top menu; see previous page) and
similarly rendered as tabular data. The difference is that only the time (i.e.,
duration) of the labeled instances is considered. For example, 100 individual
labeled instances totaling 2 minutes will be only considered as 2 minutes; the fact
that there are 100 labeled instances has no effect here. See the screenshot below.

Nested Codes Statistics Calculated by Time
(Excel® on Top; V-Note on Bottom)

@ V-NotePro File Online Edit View Timeline Transcript Playback Tools Help ® 33 2 F 00%xBS W Mon1add Q @ =
mea . > A
Insert Page Layout Formulas Data Review
v )] a
% Calib * 12 * A~ A~ = " ¥ Wrap Text General - Lad Y-
é & = Delote .
B I V A - Merge & Center * $i20%.1 1% Conditional Format  Cell Sort &

~ = S - Formatting as Table  Styles u_ Format * v Fier
Al v fr levell

A L] 14 ] 4 ¥ G L | ) K
1 lewell % Time of Total Video Level 2 % Time of Total Video % Time of Level 1 Level 3 % Time of Total Video % Time of Level 1 % Time of Lewel 2 Level 4 % Time of Total Video % Time of
2 Group Marmony 24.34% Amy N 12.19% S0.06% Briana 6.08% 24.98% 49.89% Onagy 319%
3
4
s
6
7
L
9
o0e V-Note Pro 2.6.1 [Untitied]
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Shown in the screenshot is a group of singers. Their time spent singing in whole-
group harmony is represented by the blue line on the top timeline. Amy takes lead
for the latter half (about 50% of this the whole-group time). Each singer takes lead
for a time that is roughly half of her predecessor until finally all are singing in
harmony again when Darlene joins the lead.

As each singer leads about half of the time of her predecessor, we can understand
the descriptive statistics in the Excel® spreadsheet above the timelines. In the data
below, we see - p- ” :

that Briana Level 3 % Time of Total Video % Time of Level 1 % Time of Level 2 Lewvs
sang for 6.08%  § ariana 6.08% 24.98% 49.89% Cing
of the time of
the total video, 24.98% of the time of “Level 1” (aka group harmony) and about half
(49.89%) of the time of the prior singer, Amy.

As levels of nested labels become deeper and deeper (i.e, more levels of sub-labels),
with each successive level, another level of data is added: % Time of Level 1, 2, 3, 4,
5, and so on. This allows for cross comparisons of just the right data.

If you are interested in getting out the exact amount of time of each labeled instance
out or of all them or the number of codes, see the section on exporting the raw data.

You can also view the video here which provides details.
DL WH0O
F

Scan QR Code for Tutorial Video on Exporting Raw Data
(With Number and Total Time of Labeled Instances)

In summary, the two types of statistical calculations that can be output from V-Note
for nested labels are very similar in the way they are rendered and exported to a
spreadsheet document. They differ in that one way emphasizes duration or time of
instances and the other way emphasizes the number of labeled instances. A careful
consideration of your goals should lead you to determine which way will be of most
benefit to you.
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Boolean Analysis Functions

Once your video is labeled, if you would like to find points and regions of overlap
with more specific rules than other more general overlap calculations allow for,
Boolean Analysis Functions will help you do this. This feature will create a new label
that specifically identifies points of overlap and/or non-overlap for as many labels
(codes) as you choose.

To activate choose: File > Boolean > Add Boolean Analysis Label

This will create a new label called Boolean Analysis Label on the top of your
timelines. You should change this to be more tailored to your specific needs. This is
shown in black on the image below. You can also change the color. No hotkey is
available as this label is not directly applied, but is rather a resultant intersection of
codes of your choosing per the table, also shown below in the upper right of the
image.

This particular Boolean Analysis Label is applied to wherever: “Label 1” AND
“Label 2” OR “Label 5” co-occur. Note that to add these modifiers and variables,
use the buttons on the right in the desired order. This is to prevent typos. Add
parentheses wherever you would like to typing them.

o o Boolean Analysis ]
Naming Converkion: Boolean Operations a Labels: Operationy
“Label 1 AND "Label 2* OR “Label 5" Label 1 a ANDE

Label 2 aor¥
Label 3 a XORE
Label 4 NOT(d
Label 5 :

Label 6
Expression:

Note the black labeled instance on time is calculated and added by V-Note as a result
of the Boolean Operators entered here.
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You can also change from Boolean Operations to Set
Operations, which have the same functions but with
different language. This is offered for those who are

more familiar with this language or otherwise prefer it.

A short video can be viewed here that details Boolean
Features including those described here as well as
Boolean Key Combinations (described in Chapter 2).
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Chapter 16: Automatic Face-Blurring

On Blurring Faces

Protecting privacy in human subjects research is important and often required by
institutional review boards for research protection.

V-Note makes this easy by applying artificial intelligence on-devices (i.e., on your
computer) to identify and cover faces with a blur.

This is beta feature and MAY NOT BE PERFECT. ALWAYS VERIFY. Faces appearing
partially (half or more outside of the video), faces viewed from a long distance, faces
partially obscured and other faces may not be identified as faces and therefor may
not be blurred out correctly, constantly, or at all.

If necessary, you can manually correct any missed faces by using our drawing tools
to draw a large dot or line over a face or faces that are not correctly covered.

A well-produced video will likely be blurred appropriately, however, saving much
time.

How to Automatically Blur Faces

Copy To...
Copy Description Notes
Edit

To use this feature, Right-Click over any : g:('f;:n seqment
labeled instance or over whitespace within

the timelines. Choose to “Blur Faces in
Selection” (apply blurring only within the

timespan of the labeled instance selected) Select Thom Range
or “Blur Faces Over the Entire Video. Select All

Tags 3

Add to Multi-Project Workshop

Start Playback
Play From Here
Jump To Time

will vary widely as a function of your: Preview in...
computer speed, RAM, length of the video, AutoTranscribe Selection

The A.L will then proceed. The time taken

. . AutoTi ibe Entire Vid
resolution of the video, number and FroTranserve Bie Teee

frequency of faces present, etc. This may be
from several minutes to several hours.

Blur Faces in Selection
Blur Faces Over Entire Video

Remove Blurring in Selection
Remove All Blurring

The face-blurring will NOT export to videos
made with V-Note. If exporting a video, faces would then be exposed. If you do not
want your collaborators in analysis to see the faces under any circumstance, choose
security setting “Restricted Playback” (see p. 28). Face blurring is also not
supported by the V-Note Web Player. If using face blurring, share only in-app.
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Chapter 17: Mapping Labeled Instances to Images

How to Map Labeled Instances to Images

If you would like to
associate your labeled
instances to positions
on an image, this is the
setting for it. Just click

on the right
side of the
screen. 0 01:10:00 01:20:00

This feature can be used
to link segments to their
physical location on a
house or building
blueprint, a field of play,
or any type of visual
representation as you may desire.

Dragging and placing labeled instances to any position on the image/map/etc. will
link them to that position. They will be represented as shown below.
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Exporting the data can be done
with a “heatmap” showing a color
gradient representing the count
or the duration of segments.

Altering rows and columns can
adjust resolution to your needs.
You may wish to experiment some
with output settings to suit your
needs.
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Export Map Data to Spreadsheet

Mode +/ Duration of segments

Count of segments
Filename:

Heatmap Colors: = None

Spreadsheet Resolution Preserve aspect ratio

Rows: | | 2 |
Columns: | | 2 |

Cancel
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